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DS-C330/DS-C490 User's Guide

Welcome to the DS-C330/DS-C490 User's Guide.
For a printable PDF copy of this guide, click here.

Note: The illustrations in this guide are for reference only. Although they may differ slightly from the
actual product, the operating methods are the same unless otherwise noted.

Note: Availability of products in this guide varies by country.



Product Basics

See these sections to learn about the basic features of your product.

Product Features

Product Parts Locations

Scanner Position

Using the Control Panel

Changing the Power Off and Sleep Timer Settings
Available Software

Product Features
Your product includes the following special features.
» Scanning Passports and Booklets
You can scan originals such as passports or booklets (DS-C490 only) using the straight path position.

Note: For DS-C330 models, an optional passport carrier sheet is required when scanning passports.

With the scanning software, you have the option of saving only the identification pages of your
passport (Windows only). See the software help for more information.

Document Capture Pro software allows you to read the MRZ (Machine Readable Zone) of a passport
and convert information such as name, nationality, and passport number into text data, which can then
be exported in CSV or XML format (Windows only). See the Document Capture Pro documentation for
details.

« Glass Surface Stain Detection

When the Detect Glass Dirt setting is enabled (Epson Scan 2 Utility > Scanner Setting tab >
Detect Glass Dirt), the scanner detects any stains on the glass surface inside the scanner and
displays a notification on your computer screen. When this notification is displayed, clean the glass
surface inside the scanner with a genuine Epson cleaning kit or a soft cloth.

Note: Some stains may not be accurately detected. If detection does not work correctly, try changing
the settings. If no stains are detected, select On-High. If stains are detected incorrectly, select On-
Low or Off.

* Text Enhancement



You can use Text Enhancement settings (Epson Scan 2 > Advanced Settings tab > Text
Enhancement > Settings) to emphasize light letters and remove dotted patterns in the background of
difficult to read originals. You can also correct scanned images when the corners or edges of the
original are folded or torn, or when a shadow appears around the scanned image. The missing edges
or corners will be automatically filled with the color of the original document.

Note: When using Document Capture Pro, you can open the Epson Scan 2 screen by clicking the
Detailed Settings button on the Scan Settings screen.

« Document Protection

When the Paper Protection setting is enabled (Epson Scan 2 Utility > Scanner Setting tab > Paper
Protection), scanning stops immediately when the following conditions are detected:

» A paper feed error has occurred
» An original is fed at an angle
» The combination of the original and the scanner position does not match

Note: Some feed errors may not be accurately detected. If detection does not work correctly, try
changing the settings. If no errors are detected, select On-High to increase the sensitivity. If errors are
detected incorrectly, select On-Low to decrease the sensitivity. Select On-Medium to detect stapled
originals and skewed originals that the lower setting could not detect.

* Double-feed Detection

Set the timing to stop operations when a double feed is detected (Epson Scan 2 Utility > Scanner
Setting tab > Double Feed Stop Timing). Select Inmediate to stop scanning immediately after any
double feed is detected. Select After Eject to stop scanning the next document.

Parent topic: Product Basics
Related references
Scanner Position

Related tasks

Loading Passports

Loading Booklets (DS-C490)

Scanning in Epson Scan 2

Related topics

Scanning with Document Capture Pro or Document Capture



Product Parts Locations
See these sections to identify the parts on your product.

Product Parts - Front

Product Parts - Back

Product Parts - Inside

Optional Accessories and Replacement Parts

Parent topic: Product Basics

Product Parts - Front

Input tray extension

Input tray
ADF (Automatic Document Feeder)

A WODN -~

Edge guides
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Input tray paper support (supports originals ejected on the input tray side)
Input tray paper support button
Output tray paper support (supports originals ejected on the output tray side)

5
6
7
8

Output tray paper support button; press to raise the output tray paper support

Output tray; originals scanned in the vertical path position are ejected here
Vertical path cover

Output slot; originals scanned in the straight path position are ejected here
Control panel

a b WN -

Security slot

Parent topic: Product Parts Locations
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Product Parts - Back

1 Scanner position selector
Use to change the scanner position between vertical path and straight path.
2  Cable holder (secures the cables neatly to the bottom of the scanner)

Caution: Do not secure the AC adapter cord and USB cable to the cable holder if the cables are
twisted, bent, tangled or otherwise damaged.

3  USB port
DC inlet

Parent topic: Product Parts Locations
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Product Parts - Inside

1 Scanner cover

2  Separation roller
3  Pickup roller

Parent topic: Product Parts Locations

Optional Accessories and Replacement Parts

U.S. and Canada: You can purchase optional accessories and replacement parts at epson.com (U.S.
sales) or epson.ca (Canadian sales). You can also purchase accessories from an Epson authorized
reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in
Canada.

Latin America: You can purchase optional accessories and replacement parts from an Epson
authorized reseller. To find the nearest reseller, go to latin.epson.com. Or you can contact your nearest
sales office as described in "Where to Get Help".

Note: Availability of accessories varies by country.

13


https://www.epson.com
https://www.epson.ca
http://latin.epson.com

Part Part number
Carrier sheet (5) B12B819051
Passport carrier sheet (DS-C330) B12B819651
Roller assembly kit B12B819731
Cleaning kit B12B819291

Using a carrier sheet allows you to scan irregular shaped originals or originals that can easily be
scratched. You can only load one carrier sheet in the straight path position.

With DS-C490, you can scan passports as is, but if you want to protect the passport while scanning, use
a passport carrier sheet. With DS-C330, a passport carrier sheet is required when scanning passports.

Note: Use only the carrier sheets specified above. Do not use a carrier sheet that is scratched.

Parent topic: Product Parts Locations

Scanner Position

You can change the scanner position between vertical path position and straight path position depending
on what types of originals you want to scan. See the link at the end of this section for more information
on scanner positions used for various types of originals.

Caution: Be careful not to pinch your fingers or any cables when you change the position of the scanner,
otherwise injury or damage may occur.

14



Vertical path position

When scanning multiple sheets of standard-size originals, or thin paper or receipts, pull the scanner
position selector on the back of the product and tilt the scanner forward into the vertical path position.

&

Note: When the scanner is changed to the vertical path position, the 4&' position light on the control
panel turns off.

15



In the vertical path position, originals loaded in the input tray are ejected to the output tray at the top of
the scanner.

Straight path position

When scanning thick originals such as passports, pull the scanner position selector on the back of the
product and tilt the scanner backward into the straight path position.

&y

16




Note: When the scanner is changed to the straight path position, the 4& position light on the control
panel turns on.

’ T

In the straight path position, originals loaded in the input tray are ejected to the output slot at the front of
the scanner.

*.

Parent topic: Product Basics

Related references
Scanner Positions

17



Using the Control Panel
See these sections to learn about the control panel and select control panel settings.
Control Panel Buttons and Lights
Parent topic: Product Basics

Control Panel Buttons and Lights

Buttons
DS-C330

{D’ power button
2 @' stop button

3 ":I:" start button

18



DS-C490

'd-} power button

I*™ siow mode button

@' stop button
‘3} start button

19




Lights
DS-C330

1 U ready light
On: The scanner is ready to be used.
Flashing: The scanner is scanning, waiting to scan, processing, or sleeping.
Off: The scanner power is off or an error has occurred.

*’E scanner position light (turns on when the scanner is in the straight path position)

3 !error light

20



DS-C490

(G =av )
Ld) > @ @J
0 7]
@%/

1 U ready light
On: The scanner is ready to be used.
Flashing: The scanner is scanning, waiting to scan, processing, or sleeping.
Off: The scanner power is off or an error has occurred.

I siow mode light
*’E scanner position light (turns on when the scanner is in the straight path position)

4 !error light

Parent topic: Using the Control Panel

Changing the Power Off and Sleep Timer Settings

You can use the Epson Scan 2 Utility to change the time period before the scanner enters sleep mode
and turns off automatically.

21



1. Do one of the following to access the Epson Scan 2 Utility:

* Windows 11: Click , then search for Epson Scan 2 Utility and select it.

- Windows 10: Click I and select EPSON > Epson Scan 2 Utility.
* Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select
EPSON > Epson Scan 2 > Epson Scan 2 Utility.

* Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2
Utility.

2. Click the Power Save tab.

E Epson Scan 2 Utility »
Scanner ¢ | EPSON w

information Counter |Power Save | Mantenance Adjustments Scanver Settng  Other

&

Sleap Tiver (manutes) : | 10 =
Power OFf Tener (manutes)

A power or AC adapter : | OFf

Direct Powes On : | OFf o

17

3. Select the length of time after which you want the scanner to go to sleep as the Sleep Timer setting.

22



4. Select the length of time after which you want the scanner to automatically turn off when not in use
as the AC power or AC adapter setting. You can also select Power Off If Disconnected to turn off

the timer.

5. Turn on the Direct Power On setting if you want the scanner to turn on when it is connected to the
power source, without pressing the power button.

6. Click Set to save the settings.
7. Close the Epson Scan 2 Utility.

Parent topic: Product Basics

Available Software

The table below provides an overview of the software available for your product.

You can download and install the necessary software from the Epson website using the instructions on

the Start Here sheet.

Note: An internet connection is required to obtain the product software.

Software

Description

Document Capture Pro
(Windows) or Document
Capture (Mac)

Allows you to easily and efficiently digitize originals if you want to save
scanned data to your computer. You can register a set of operations,
such as Scan-Save-Send, as a “job” and assign the job to the scanner's
control panel so you can perform the operation by simply pressing the
button. See the software help for detailed information on using the
application.

Epson Scan 2

Scanner driver that allows you to control the scanner. You can adjust
the size, resolution, brightness, contrast, and quality of the scanned
image. See the software help for more information on using the
application.

Note: For Windows Server operating systems, make sure the Desktop
Experience feature is installed.

23




Software Description

Epson Software Updater Periodically checks for software updates and then notifies you and
installs the software if an update is available. You can select the interval
for update checks and make settings for receiving update notifications.
In addition to driver updates, also allows you to update product firmware
and previously installed applications, and install additional software that
is compatible with your product.

Parent topic: Product Basics

24



Loading Originals

Follow the instructions here to load your originals into the product.

Note: The illustrations are for reference only. Although they may differ slightly from the actual product,
the steps are the same unless otherwise noted.

Scanner Positions

Loading Originals in the Input Tray

Loading Large Originals

Loading Long Paper

Loading Booklets (DS-C490)

Loading Passports

Loading Multiple Sizes of Originals in the Input Tray
Loading Plastic and Laminated Cards in the Input Tray
Loading Special Originals

Scanner Positions

Your product uses two different positions for scanning, depending on the type of original being scanned.
The table below shows the scanner position used for various types of originals.

For details on how to change the scanner position, see the link at the end of this section.

Scanner Position | Description Supported Originals

Vertical path Use the vertical path position for . Standard size originals up to this size:

position scanning thin paper, receipts, or multiple Letter (8.5 x 11 ir?ches P '
sheets of standard-size originals. [216 x 2?9 mm]) or Ad (8.3 x 1.7
Scanned originals are ejected from the inches [210 x 297 mm])
output tray at the top of the scanner. - Thin paper (40 g/m2)

* Receipts less than 15.5 inches
(393.7 mm) in length

» Business cards

» Mixture of originals

25



Scanner Position

Description

Supported Originals

Straight path
position

i

Use the straight path position for
scanning thick or long documents,
envelopes, passports, cards, and other
irregular size originals.

Scanned originals are ejected from the
output slot at the front of the scanner.

When scanning in the straight path
position, make sure there is enough
space in front of the scanner for the
ejected originals. If the scanned image
is affected by the originals ejecting
below the product, try placing the
product on the edge of a table where the
ejected originals can drop freely.

Large size originals (for DS-C330,
use a carrier sheet)

Long paper

Receipts over 15.5 inches (393.7 mm)
in length

Plastic cards
Laminated cards
Booklets (DS-C490 only)

Passports (for DS-C330, use a
passport carrier sheet)

Picture post cards

Important or essential originals (in a
carrier sheet)

Envelopes

Irregular size originals (in a carrier
sheet)

Parent topic: Loading Originals

Related references
Scanner Position

Loading Originals in the Input Tray

You can load originals that meet the document specifications in the input tray.

Caution: Do not load valuable original documents or artwork, directly into the input tray. This may
wrinkle or damage the original. Load these originals using an optional carrier sheet.

The steps below describe loading originals of the same size. To load originals of multiple sizes at once,
see the link at the end of this section.

26




1. Make sure the 4& scanner position light is off.

Note: If the 4& scanner position light is on, pull the position selector to the right and tilt the scanner
forward.

&

27



2. Open the input tray.

28



3. Raise the input tray extension.

29



4. Slide the input tray edge guides all the way out.

5. If you are loading a multi-page original, fan your stack of originals.

Note: If you are loading an original that is 15.5 inches (393.8 mm) or longer, load only one sheet at a
time.

)/

30



Stack the originals with the printed side facing up and slide the stack so the leading edge is at an
angle as shown.

31



7. Do one of the following to load originals:

» Load standard originals into the input tray printed side up and top edge first, and guide them in
until they meet resistance.

32



+ If you are loading hole-punched originals, load them with the holes facing down or to the side as
shown. The holes must be within 1.2 inches (30 mm) of the edge of the originals.

+ If you are loading folded originals, load them so that the valley fold (the dotted line) is at the front
of the scanner and on the ADF side as shown. You can load up to 10 sheets. Originals with a hard

33



fold line may not be fed properly. For originals such as these, flatten them so that the height of the
fold is 0.2 inches (5 mm) or less before loading it.

34



+ If you are loading thick originals (127 g/m? or more), switch the scanner to the straight path
position and load only one original at a time. If thicker paper does not eject properly, try placing the
product on the edge of a table where the ejected originals can drop freely.

Note: You can check the scanner position on the control panel. If the *E scanner position light is

on, the scanner is in the correct position. If the #£ scanner position light is off, pull the lever on the
back to tilt the scanner backwards.

35



+ If you are loading irregular shaped originals, switch the scanner to the straight path position and
load the original into an optional carrier sheet with the back of the original facing up.

Flip the carrier sheet over before loading it in the input tray.

36



Load the original into the input tray as shown.

Note: Use only the carrier sheet designed for your product. The carrier sheet is automatically
recognized by the product by the two small rectangular holes on the front edge. Keep the holes

37



clean and not covered. Do not load a carrier sheet that has scratches on it or one that has been
scanned more than 3,000 times.

+ If you are loading envelopes, switch the scanner to the straight path position and load the
envelope short side first with the side to be scanned facing up. For envelopes with the flap side on

38



the shorter side, you can load the envelope with the flap side facing up. Insert the envelope into
the ADF until it meets resistance.

_______

\ o=
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8. Adjust the edge guides to fit the edges of the original so that there are no gaps. Otherwise, the
original may skew.

[
G

If the document extends beyond the input tray extension, support the original as it enters into and ejects
from the product to prevent it from skewing. When scanning thin originals or originals that tend to curl
after scanning, we recommend extending the input and output tray paper supports. After loading the
original, press both of the buttons to raise the supports.

Parent topic: Loading Originals

Related references

Original Document Specifications

Plastic and Laminated Card Specifications
Special Original Specifications

40



Scanner Positions

Optional Accessories and Replacement Parts
Related tasks

Loading Multiple Sizes of Originals in the Input Tray

Related topics
Scanning

Loading Large Originals

You can load large originals up to A2 (16.5 x 23.4 inches [420 x 594 mm]) size. Make sure the original

meets the specifications before loading it. Also make sure there is enough space in front of the scanner
for the ejected originals.

Note: Originals larger than A3 (11.7 x 16.5 inches [297 x 420 mm]) must be folded in half. You can scan
both sides of the original and stitch the images together using Document Capture Pro or Epson Scan 2.

Note: To combine the scanned images, open Document Capture Pro and click the Detailed Settings
button on the Scan Settings screen. Then, select Double-Sided as the Scanning Side setting and

select Left & Right as the Stitch Images setting in the Epson Scan 2 window. See the software help for
details.

1. Make sure the -"i"i scanner position light is on.

LY



Note: If the 4& scanner position light is off, pull the position selector to the right and tilt the scanner

el

backwards.

2. Open the input tray.



3. Raise the input tray extension.

4. Slide the input tray edge guides all the way out.

SEE
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5. Do one of the following:

+ DS-C330: Fold the original in half so that the side to be scanned is facing out, then place your
original in the carrier sheet as shown.

Flip the carrier sheet over before loading it in the input tray.

<] -[F-[:

+ DS-C490: Fold the original in half so that the side to be scanned is facing out.

Z Lo L
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6. Load the folded original or the carrier sheet (DS-C330) in the input tray with page 1 facing up as
shown, then guide it in until it meets resistance.

45






7. Adjust the edge guides to fit the edges of the original or the carrier sheet (DS-C330) so that there are
no gaps. Otherwise, the original may skew.

) @/ﬁ

8. Turn off the Detect Double Feed setting on the Main Settings tab in Epson Scan 2.

Note: When using Document Capture Pro, you can open the Epson Scan 2 screen by clicking the
Detailed Settings button on the Scan Settings screen.

When scanning with a carrier sheet (DS-C330), select Auto Detect as the Document Size setting in
Epson Scan 2 and Paper Skew as the Correct Document Skew setting.

The leading edge of the original must be placed at the binding edge of the carrier sheet when scanning
an original approximately 11.7 inches (297 mm) long. Otherwise, the length of the scanned image may
be longer than intended as the scanner scans to the end of the carrier sheet when you select Auto
Detect as the Document Size setting in the Epson Scan 2 window.

Only use a carrier sheet designed for your product. The carrier sheet is automatically recognized by the
product by detecting two small rectangular holes on the leading edge. Keep the holes in the carrier sheet
clean and uncovered. Do not use a carrier sheet that is scratched or has been scanned more than 3,000
times.

Parent topic: Loading Originals

Loading Long Paper

You can load long paper up to 120 inches (3048 mm) (DS-C330) or 220 inches (5588 mm) (DS-C490)
long in the input tray. Make sure the original meets the specifications before loading it.

Note: The scanning speed is slower when scanning long paper.
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1. Make sure the 4& scanner position light is on.

’ M

Note: If the 4& scanner position light is off, pull the position selector to the right and tilt the scanner
backwards.

&
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2. Open the input tray.

3. Raise the input tray extension.
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4. Slide the input tray edge guides all the way out.
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5. Load the original into the input tray printed side up and top edge first, and guide it in until it meets
resistance.
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When loading long paper, support it at the input side so that it does not drop out of the ADF, and the
output side so that the ejected paper does not get jammed.

6. Adjust the edge guides to fit the edges of the original or the carrier sheet (DS-C330) so that there are
no gaps. Otherwise, the original may skew.

) @/‘_

52



Note: Support the original with both hands to prevent it from skewing while scanning.

7. Specify the paper size in the Epson Scan 2 window.

Note: When using Document Capture Pro, you can open the Epson Scan 2 screen by clicking the
Detailed Settings button on the Scan Settings screen.

You can scan long paper in the following resolutions:
DS-C330:

» 50to 300 dpi: 15.5 to 120 inches (393.7 to 3048 mm)
» 301 to 600 dpi: 15.5 inches (393.7 mm) or less
DS-C490:

» 50 to 200 dpi: 215 to 220 inches (5461 to 5588 mm)
+ 201 to 300 dpi: 53 to 215 inches (1346 to 5461 mm)
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+ 301 to 600 dpi: 53 inches (1346 mm) or less
Parent topic: Loading Originals

Loading Booklets (DS-C490)

You can load small booklets into the scanner. Make sure the booklet meets the specifications before
loading it.

Note: You can scan A5-sized booklets that are less than 0.20 inches (5 mm) thick when closed.

1. Make sure the 4& scanner position light is on.

: )

{

Note: If the 4&' scanner position light is off, pull the position selector to the right and tilt the scanner
backwards.

&
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2. Open the input tray.

3. Raise the input tray extension.
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4. Slide the input tray edge guides all the way out.
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5. Load the original into the input tray printed side up and with the thicker edge (the side with more
pages) facing first, and guide it in until it meets resistance.

4 o

/0

6. Adjust the edge guides to fit the edges of the original so that there are no gaps. Otherwise, the
original may skew.

a—
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7. Support the top of the booklet with your hand to prevent it from closing or falling out of the ADF. If the
scanned images are affected by the originals ejecting below the product, try placing the product on
the edge of a table where the ejected originals can drop freely.

Note: When scanning booklets, select Booklets as the Document Size and turn off the Detect
Double Feed setting on the Main Settings tab in Epson Scan 2.

Parent topic: Loading Originals

Loading Passports

You can load A5-sized passports that are less than 0.20 inches (5 mm) thick in the input tray. For thicker
passports, use an optional passport carrier sheet. (DS-C330 requires an optional passport carrier sheet
for all passports). Make sure the original meets the specifications before loading it.
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1. Make sure the 4& scanner position light is on.

’ M

Note: If the 4& scanner position light is off, pull the position selector to the right and tilt the scanner
backwards.

&
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2. Open the input tray.

3. Raise the input tray extension.
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4. Slide the input tray edge guides all the way out.
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5. Load the passport into the input tray printed side up and with the thicker edge (the side with more
pages) facing first, and guide it in until it meets resistance (DS-C490).

If you are using an optional passport carrier sheet (required for DS-C330), load the passport into the
carrier sheet printed side up and with the thicker edge (the side with more pages) facing first, then
place the carrier sheet into the input tray and guide it in until it meets resistance.
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Note: Do not use a passport carrier sheet that is scratched or has been scanned more than 3,000
times. Use only the passport carrier sheet that is designed for your product.

Adjust the edge guides to fit the edges of the original so that there are no gaps. Otherwise, the
original may skew.

DS-C330:
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DS-C490:
.

o)) (B

7. Support the top of the passport with your hand to prevent it from closing or falling out of the ADF. If
the scanned images are affected by the originals ejecting below the product, try placing the product
on the edge of a table where the ejected originals can drop freely.

DS-C330:

65



DS-C490:

Note: When scanning passports, select Passport as the Document Size and turn off the Detect
Double Feed setting on the Main Settings tab in Epson Scan 2.

Note: When using Document Capture Pro, you can open the Epson Scan 2 screen by clicking the
Detailed Settings button on the Scan Settings screen.

Parent topic: Loading Originals

Loading Multiple Sizes of Originals in the Input Tray

You can load originals of different sizes, paper types, and thicknesses at one time in the input tray. Just
make sure they meet the original document specifications.

Caution: Do not load valuable original documents or artwork directly into the input tray. This may wrinkle
or damage the original. Load these originals using an optional carrier sheet. If originals are fed askew,
check the scanned images. If the image is skewed, load fewer originals and scan again. If originals are
frequently jammed or not fed correctly, press the 1™ siow mode (DS-C490) button to see if that solves
the problem.

Note: You can also scan originals of different paper types and thickness by loading them one by one and
selecting Automatic Feeding Mode on the Main Settings screen in Epson Scan 2.
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Note: When using Document Capture Pro, you can open the Epson Scan 2 screen by clicking the
Detailed Settings button on the Scan Settings screen.

1. Make sure the *& scanner position light is off.

Note: If the ‘&r scanner position light is on, pull the position selector to the right and tilt the scanner
forward.

&
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2. Open the input tray.

68



3. Raise the input tray extension.
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4. Slide the input tray edge guides all the way out.

5. Load the originals in the center of the input tray in descending order of paper size with the widest at
the back and the narrowest at the front. Slide them in until they meet resistance. Make sure the
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printed sides are facing up and the leading edges are aligned in the input tray (refer to the triangle on
the scanner as a guide).

( )
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6. Slide the edge guides against the edges of the widest original.

|
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Epson Scan 2 allows you to preview the first side of your original. Load only the first original into the
ADF, and then press the Preview button. The preview window opens, the previewed image is displayed,
and the page is ejected from the scanner. Replace the ejected page together with the rest of the
originals.

When loading and previewing multiple originals at once, or if you cancel scanning in the middle of a
batch, the next page may already be in position when scanning stops. Open the scanner cover to
remove the page, then reload it with the first page and the rest of the originals.

Original Document Specifications
Parent topic: Loading Originals

Related references
Scanner Positions

Related topics
Scanning

Original Document Specifications
You can load original documents that meet these specifications in your product.
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Paper type Paper size Paper weight Loading capacity

Plain paper Legal (8.5 x 14 inches 10.5Ibto 34 1b In the vertical path position
-

Fine paper [216 x 356 mm]) (40 to 127 g/m?) (in the Thickness of stack: under

Recycled paper

Letter (8.5 x 11 inches
[216 x 279 mm)])

A4 (8.3 x 11.7 inches
[210 x 297 mm])

B5 (7.2 x 10.1 inches
[182 x 257 mm])

A5 (5.8 x 8.2 inches
[148 x 210 mm])

B6 (5 x 7.2 inches
[128 x 182 mm])

vertical path position)

10.5t0 110 Ib
(40 to 413 g/m?) (in the
straight path position)

A6 (4.1 x 5.8 inches
[105 x 148 mm)])

A8 (2.1 x 2.9 inches
[52 x 74 mm])

10.5t0551b
(40 to 209 g/m?) (in the
vertical path position)

10.5t0 110 Ib
(40 to 413 g/m?) (in the
straight path position)

0.09 inches (2.4 mm)

10.5 Ib (40 g/m2): 20
sheets’

21 1b (80 g/m?): 20 sheets
24 1b (90 g/m?): 18 sheets
28 Ib (104 g/m?): 15 sheets
34 1b (127 g/m?): 12 sheets

1 sheet (in the straight path
position)

Loading capacity varies
depending on the paper
type.




Paper type

Paper size

Paper weight

Loading capacity

Long paper

Width: up to 8.5 inches
(215.9 mm)

Length: 15.5t0 120
inches (393.7 to 3048
mm) (DS-C330)

15.5t0 220 inches (393.7
to 5588 mm) (DS-C490)

Maximum lengths
according to the scanning
resolution:

DS-C330:

+ 50 to 300 dpi: 120
inches (3048 mm)

+ 301 to 600 dpi: 30
inches (762 mm)

DS-C490:

+ 50 to 200 dpi: 220
inches (5588 mm)

+ 201 to 300 dpi: 215
inches (5461 mm)

» 301 to 600 dpi: 53
inches (1346 mm)

13 to 351b (50 to 130 g/m?)

1 sheet

Paper business
cards

2.1 x 3.4 inches (55 x 89
mm)

Up to 56 Ib (210 g/m?)

Vertical path position: 5
cards

Thickness of stack: under
0.09 inches (2.4 mm)
Straight path position: 1
card
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Paper type Paper size Paper weight Loading capacity

Receipts Width: 2 to 8.5 inches 53 to 77 g/m? Vertical path position:

(50.8 t0 215.9 mm) Thickness of stack: under
Length: 2 to 120 inches 0.09 inches (2.4 mm)

(50.8 to 3048 mm) Straight path position: 1

receipt

' For thin originals, extending the input and output tray paper supports is recommended

Warning: Do not load the following types of originals directly in the scanner, or they may be damaged or
may damage the scanner:

* Photos

» Booklets or passports that are thicker than 0.19 inches (5 mm) when closed
» Fabric or other non-paper originals

» Originals containing staples or paper clips

+ Originals with wet ink or glue

* Ripped originals

» Heavily wrinkled or curled originals

» Transparencies

+ Originals with carbon paper backing

» Originals with attached sticky notes

You can scan ripped, wrinkled, or curled originals using a carrier sheet (not included).

Do not feed valuable artwork or important documents into the scanner directly. Misfeeding may wrinkle
or damage the original. When scanning these types of originals, use an optional carrier sheet.

For thick passports and passports with a slightly expanded binding edge, use a passport carrier sheet
(DS-C490).

Caution: Be careful when loading the following types of originals, or they may be damaged or may not
scan successfully:

+ Originals with uneven surfaces, such as embossed documents or letterhead

» Coated paper
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* Glossy originals

* Thermal paper

* Ripped, curled, or wrinkled originals
+ Originals with tears or fold lines

» Perforated originals

 Originals with labels or stickers

» Carbon-less paper

 Originals that have just been printed

Warning: Carbon-less paper contains chemical substances that may damage the rollers inside the
scanner. Make sure you clean the pickup roller and the separation rollers regularly. Scanning carbon-
less paper may reduce the service life of the rollers compared with scanning plain paper.

Note: When attempting to scan these types of originals, note the following:
* When scanning wrinkled originals, smooth out the wrinkles before loading if possible.

» Slow down the feeding speed using the I™ siow mode button (DS-C490) when scanning wrinkled
originals, and smooth out the wrinkles before loading if possible.

» Use the optional carrier sheet to scan originals that are delicate or wrinkled.

« If originals are incorrectly detected as double feeds, select Off as the Detect Double Feed setting in
Epson Scan 2.

» Labels or stickers must be firmly adhered to the scanned original with no exposed glue.

* When scanning an original with labels or stickers that look like they might come off easily, use a carrier
sheet (not included) and scan the original in the straight path position.

» Try to flatten curled originals as much as possible.

» For originals with folds, flatten the original so that the height of the fold is 0.2 inches (5 mm) or less
before loading.

Parent topic: Loading Multiple Sizes of Originals in the Input Tray

Loading Plastic and Laminated Cards in the Input Tray
You can load plastic and laminated cards that meet the card specifications in the input tray.
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1. Make sure the 4& scanner position light is on.

’ M

Note: If the 4& scanner position light is off, pull the position selector to the right and tilt the scanner
backwards.

&
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2. Open the input tray.

3. Raise the input tray extension.
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4. Slide the input tray edge guides all the way out.

5. Load plastic or laminated cards (printed side up and long edge first) into the input tray horizontally,
and slide them in until they meet resistance.
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Note: Do not load plastic cards vertically.

6. Adjust the edge guides to fit the edges of the original so that there are no gaps. Otherwise, the
original may skew.

L1/
R (-

7. Select the card type and turn off the Detect Double Feed setting on the Main Settings tab in Epson
Scan 2. If you do not disable the Detect Double Feed setting and a double feed error occurs,
remove the plastic or laminated card from the input tray and reload it.

Note: When using Document Capture Pro, you can open the Epson Scan 2 screen by clicking the
Detailed Settings button on the Scan Settings screen.

Plastic and Laminated Card Specifications
Parent topic: Loading Originals

Related references
Scanner Positions

Related topics
Scanning

Plastic and Laminated Card Specifications
You can load original plastic and laminated cards that meet these specifications in your scanner.
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Paper type Paper size Paper thickness Loading capacity

Plastic cards, 2.1 x 3.3 inches 0.05inch (1.24 mm) |1 card (horizontal)
embossed (ISO 7810 | (54 x 85.6 mm) maximum
ID-1 compliant)
Plastic cards, standard 0.03 inch (0.76 mm) to
(1ISO 7810 ID-1 0.04 inch (1.1 mm)
compliant) smaller than 0.03 inch
(0.76 mm)

Laminated cards 4.7 x 5.9 inches (120 0.03inch (0.76 mm) |1 card

x 150 mm) or smaller maximum

Note: Plastic cards with glossy surfaces may not scan properly.

Parent topic: Loading Plastic and Laminated Cards in the Input Tray

Loading Special Originals

You can load thick, folded, or irregularly shaped originals in the input tray using an optional carrier sheet.
You can also load envelopes. Make sure the originals meet the specifications for special originals before
loading them.

Note: Make sure there is enough space in front of the scanner for the ejected originals.

1. Make sure the '-'"rf scanner position light is on.
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Note: If the 4& scanner position light is off, pull the position selector to the right and tilt the scanner

el

backwards.

2. Open the input tray.



3. Raise the input tray extension.

4. Slide the input tray edge guides all the way out.

SEE
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5. Load envelopes vertically in the input tray with the printed side down and the flap facing as shown.
Slide in the envelopes until they meet resistance. Skip to step 8.

_______
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Do one of the following to load folded or irregularly shaped originals using a carrier sheet:

Note: Use only the carrier sheet designed for your product. The carrier sheet is automatically
recognized by the product by the two small rectangular holes on the front edge. Keep the holes
clean and not covered. Do not load a carrier sheet that has scratches on it or one that has been
scanned more than 3,000 times.

» For alarger original, fold it as shown and place it in the center of an optional carrier sheet. Make
sure the illustration on the front edge of the carrier sheet is facing up. To scan both sides and
stitch them together, set the appropriate setting in Epson Scan 2.

» For anirregularly shaped original, load it in the center of an optional carrier sheet with the printed
side face down. Make sure the illustration on the front edge of the carrier sheet is facing up. If you
are loading originals that are 11.7 inches (297 mm) or shorter, place the leading edge of the
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original against the binding of the carrier sheet, as shown. Otherwise, the product may not detect
the correct length of the original.

R
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7. Load the carrier sheet in the input tray as shown until it meets resistance.
Folded original

87



Irregularly shaped original

8. Slide the edge guides against the edges of the carrier sheet.

o G
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9. Turn off the Detect Double Feed setting on the Main Settings tab in Epson Scan 2 when scanning

special originals.

Note: If the Document Size setting on the Main Settings tab in Epson Scan 2 is set to Auto Detect,
Paper Skew is automatically selected as the Correct Document Skew setting.

Note: When using Document Capture Pro, you can open the Epson Scan 2 screen by clicking the
Detailed Settings button on the Scan Settings screen.

Special Original Specifications

Parent topic: Loading Originals

Related references

Optional Accessories and Replacement Parts

Scanner Positions

Related topics
Scanning

Special Original Specifications
You can load envelopes, or large, thick, or folded originals that meet these specifications in your

scanner.
Paper type Paper size Paper thickness Loading capacity
Large originals (plain [A3 (11.7 x 16.5 inches 10.5t052 b 1 sheet
paper, fine paper, or | [297 x 420 mm]) (40 to 206 g/m?)
recycled paper) B4 (13.9 x 9.84 inches

[353 x 250 mm])
Envelopes 4.49 x 6.38 inches (114 0.015inch (0.38 mm) |1 envelope

x 162 mm)

4.33 x 8.66 inches (110
x 220 mm)

maximum

89




Paper type

Paper size

Paper thickness

Loading capacity

Irregularly shaped
originals

(load only in a carrier
sheet)

Up to this size: A4 (8.3 x 11.7
inches [210 x 297 mm])

0.012 inch (0.3 mm)
maximum

(excluding the
thickness of the carrier
sheet)

1 carrier sheet

Originals that cannot
be loaded directly into
the scanner (such as
paper that is wrinkled,
torn, stapled, etc.)

Letter (8.5 x 11 inches
[216 x 279 mm)])

Legal (8.5 x 14 inches
[216 x 356 mm])’

A2 (16.5 x 23.4 inches
[420 x 594 mm])’

A3 (11.7 x 16.5 inches
[297 x 420 mm])’

A4 (8.3 x 11.7 inches
[210 x 297 mm])

B4 (13.9 x 9.84 inches
[353 x 250 mm])’

B5 (7.2 x 10.1 inches
[182 x 257 mm)])

A5 (5.8 x 8.2 inches
[148 x 210 mm])

B6 (5 x 7.2 inches
[128 x 182 mm])

A6 (4.1 x 5.8 inches
[105 x 148 mm)])

A8 (2.1 x 2.9 inches
[52 x 74 mm])

Custom sizes up to 17 inches
(431.8 mm) wide® and 11.7
inches (297 mm) long®

0.01 inches (0.3 mm)
orless

(excluding the
thickness of the carrier
sheet)

1 carrier sheet

' Fold in half to load
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? Originals that are wider than 8.5 inches (215.9 mm) need to be folded in half

® The leading edge of the original must be placed at the binding part of the carrier sheet when scanning
originals longer than 11.7 inches (297 mm)

Parent topic: Loading Special Originals
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Scanning

You can scan your originals and save them as digital files.
Starting a Scan

Starting a Scan

After placing your originals on your product for scanning, start scanning using one of these methods.
Note: You can also scan using Document Capture Pro (Windows) or Document Capture (Mac).

Starting a Scan from a Scanner Button

Starting a Scan Using the Epson Scan 2 Icon

Starting a Scan from a Scanning Program

Scanning with Document Capture Pro or Document Capture
Scanning in Epson Scan 2

Scan Resolution Guidelines

Scanning Special Projects

Parent topic: Scanning

Starting a Scan from a Scanner Button

You can scan using the ":I:" start button on your scanner. This automatically starts Document Capture
Pro (Windows) or Document Capture (Mac) and the scan job you have assigned to the button.

Note: Make sure Epson Scan 2 and Document Capture Pro (Windows) or Document Capture (Mac) are
installed on the computer connected to the scanner.

1. Load an original in your scanner.
2. Pressthe & start button.

The scanner starts the job that was assigned to the "E:" start button in Document Capture Pro
(Windows) or Document Capture (Mac).

Note: You can view or change the scan settings using Document Capture Pro (Windows) or
Document Capture (Mac).
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Adding and Assigning Scan Jobs with Document Capture Pro - Windows
Adding and Assigning Scan Jobs with Document Capture - Mac

Parent topic: Starting a Scan

Related topics
Loading Originals

Adding and Assigning Scan Jobs with Document Capture Pro - Windows

You can add scan jobs that contain specific scan settings and use the jobs when you scan from your
product control panel or the Job Scan option in Document Capture Pro. You can save up to 30 scan
jobs.

Note: Settings may vary depending on the software version you are using. Click the Help icon in
Document Capture Pro at any time for more information.

1. Do one of the following to start Document Capture Pro:

* Windows 11: Click , then search for Document Capture Pro and select it.

* Windows 10: Click E and select Epson Software > Document Capture Pro.
+ Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

* Windows (other versions): Click E" or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window.
2. Select the Job Scan tab.
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You see a screen like this:
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Document Capture Pro
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3. Click the Job Settings button.

You see a screen like this:
Document Capture Pro G &
- | 4
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To add a scan job, click the New Job icon.

Enter a name for the new job, and select any settings as necessary from the following options:
» Scan: select the size, color, or resolution

+ Save: select the file name, file type, or destination folder

* Index: enable the index setting and choose output options for an index file

» Send: select the destination for the scanned file, or choose to email or print the file

Confirm/Test: select the job button icon and color, choose display settings, and run a test scan if
necessary

Click Save when you are finished.
The new job appears in the Job Scan window.
To assign a scan job to the product control panel, click the Button Assignment icon.

You see a screen like this:
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8.

Select the jobs that you want to assign to the product control panel using any of the pull-down
menus.

Note: The number of pull-down menus available may vary, depending on your product and any
connected options.

Click OK, then click Back.
You can now use the added scan jobs when you scan from the product control panel.

Parent topic: Starting a Scan from a Scanner Button

Adding and Assigning Scan Jobs with Document Capture - Mac

You can add scan jobs that contain specific scan settings and use the jobs when you scan from your
product control panel or Document Capture. You can save up to 30 scan jobs.

Note: Settings may vary depending on the software version you are using. See the Help menu in
Document Capture at any time for more information.

1.

2.

Start Document Capture on a computer connected to the product.

Click the Manage Job icon from the toolbar at the top of the window.
You see a window showing the current scan job list.

To add a scan job, click the + icon, enter a name for the new job, select settings as necessary, and
click OK.

You can now use the new scan job when you scan with Document Capture.

To assign a scan job to the product control panel, click the o v
window and click Event Settings.

settings icon at the bottom of the

Select the jobs that you want to assign to the product control panel using any of the pull-down
menus.

Note: The number of pull-down menus available may vary, depending on your product and any
connected options.

Click OK, then click OK again.
You can now use the added scan jobs when you scan from the product control panel.

Parent topic: Starting a Scan from a Scanner Button
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Starting a Scan Using the Epson Scan 2 Icon
You can start the Epson Scan 2 program to select scan settings, scan, and save the scanned image to a
file.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Windows 11: Click , then search for Epson Scan 2 and select it.

* Windows 10: Click I:I and select EPSON > Epson Scan 2.
* Windows 8.x: Navigate to the Apps screen and select Epson Scan 2.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select EPSON
> Epson Scan 2 > Epson Scan 2.

» Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2.
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You see an Epson Scan 2 window like this:

EEpﬁnnS{anz - o X
Scanner : |EPSU'\I v]
Scan Settings : | Default Setting v|
Main Settings  Advanced Settings
Document Source : | ADF v|
[ Automatic Feeding Mode
Scanning Side : | Double-Sided v|
Dacument Size : | Auto Detect | '__JI [
Image Type : | Black & White v
Resohtion : do
Stitch Images : | Off v]
Rotate : |0° v]
Correct Document Skew : | Paper Skew v |
[[] add or edit pages after scanning
Skip Blank Pages : |CrFI' vI
Detect Double Feed : | On v|
Image Format : [ ppF ~|
FieName © | img20190116_17044938.pdf ~|
Folder : | pocuments ~|
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Parent topic: Starting a Scan

Starting a Scan from a Scanning Program

You can start Epson Scan 2 from a TWAIN-compliant scanning program to select scan settings, scan,
and open the scanned image in the program.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software

from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

1. Open your scanning program and select its scanning option. (See your scanning program help for
instructions.)

2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a
Select Source option, choose it and select your product. With Windows, do not select a WIA option
for your product; not all scan functions will be available.
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You see an Epson Scan 2 window like this:

E Epson Scan 2 - o >
Scanner ; |EPSU\I vl
Scan Settings : | Default Setting ]

Main Settings  Advanced Settings

Document Source : | ADF v|
[ Automatic Feeding Mode
Scanning Side : | Double-Sided |
Document Size : | Auto Detect ~| I |ﬂ{,
Image Type : | Black & White v]
Resolution : o
Stitch Images : | Off v|
Rotate : | 0° ]
Correct Document Skew : | Paper Skew v|
[J Add or edit pages after scanning
Skip Blank Pages : | Off v]
Detect Double Feed : | On v|
inage Fomt [ 4
FieName : | img20150116_17044938.pdf |
Folder : | Douments v

12 e | presen || san
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Parent topic: Starting a Scan

Scanning with Document Capture Pro or Document Capture

When you scan with Document Capture Pro (Windows) or Document Capture (Mac), the program
automatically saves your scanned file on your computer in the folder you specify. You can preview and
edit the scanned file, change the scanned file settings, and send to a destination if necessary.

Scanning with Simple Scan in Document Capture Pro - Windows
Scanning with Job Scan in Document Capture Pro - Windows
Scanning with Document Capture - Mac

Parent topic: Starting a Scan
Scanning with Simple Scan in Document Capture Pro - Windows
You can use the Simple Scan option in Document Capture Pro to quickly scan an original.

Note: Settings may vary depending on the software version you are using. Click the Help icon in
Document Capture Pro at any time for more information.

Load your original in the product.
2. Do one of the following to start Document Capture Pro:

* Windows 11: Click , then search for Document Capture Pro and select it.

* Windows 10: Click E and select Epson Software > Document Capture Pro.
+ Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window.
Note: You may need to select your scanner from the list, if necessary.

3. Select the Simple Scan tab.
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You see a window like this:
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Document Capture Pro
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Select the size of your original from the Document Size menu.

If you want to change specific settings for the scan, click the Scan Settings button. Change any of
the settings as necessary and click OK. For additional settings, click the Detailed Settings button
on the Scan Settings screen.

Do one of the following:

» To scan both sides of an original, select SCAN double-sided.

» To scan the front side of an original, select SCAN single-sided.

Your product scans the original and the image appears in the Edit Scanned Results window.
Review and edit the scanned image as necessary and click Next when you are finished.

Select a destination for the scanned image, change any settings as necessary, and click Complete.

Note: If you are sending the scanned image to a server or cloud destination, you need to enter your
login information.

Parent topic: Scanning with Document Capture Pro or Document Capture
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Scanning with Job Scan in Document Capture Pro - Windows

You can create scan jobs in Document Capture Pro and use them to quickly scan originals and save
them to various destinations.

Note: Settings may vary depending on the software version you are using. Click the Help icon in
Document Capture Pro at any time for more information.

Load your original in the product.
2. Do one of the following to start Document Capture Pro:

* Windows 11: Click , then search for Document Capture Pro and select it.

* Windows 10: Click E and select Epson Software > Document Capture Pro.
+ Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

* Windows (other versions): Click E" or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window.
Note: You may need to select your scanner from the list, if necessary.

3. Select the Job Scan tab.
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You see a window like this:
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4. Select one of the scan jobs (or click Job Settings to create a new scan job).
The product scans the loaded original and saves it according to the job settings.

5. Depending on the settings for the scan job you selected, you may be able to view and edit the pages
before saving them. If so, click Complete when finished.

The scanned image is saved according to the job settings.
Parent topic: Scanning with Document Capture Pro or Document Capture
Scanning with Document Capture - Mac

When you scan with Document Capture, the program automatically saves your scanned file on your
computer in the folder you specify. You can select settings, preview, and change the scanned file
settings as necessary. Document Capture also allows you to send the scanned file directly to an email
address or printer, or upload it to a server or cloud destination.

Note: Settings may vary depending on the software version you are using. See the Help menu in
Document Capture at any time for more information.

1. Load your original in the product.

2. Open the Applications folder, open the Epson Software folder, and select Document Capture.
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You see a window like this:

LER ] Do § o
> B e 4 ws /9Ll

Lo - A | A

s =

e R

s Pt

Note: You may need to select your product from the drop-down list.

Click the @ scan icon.
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You see a window like this:

a Scan Settings

Scanner: EPSON
Source:  ADF
Double-Sided
Document Size:  Letter

e

Image Type: Auto
Rotation:  Mone
Resolution: Low H

(o] o o)
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ol
Text Enhancement

Correct Documaent Skew
Skip Blank Page

Show the confirmation dialog after scanning

? Cancel | L

Note: If you want to use a scan job that you created instead, select it from the Job list in the
Document Capture window, click the 22| Start Job button, and skip the rest of these steps.

Select any displayed scan settings you want to use.
Note: See the Help information in Document Capture for details.

If you want to select detailed scan settings, close the Scan Settings window, open the Scan menu at
the top of the Mac desktop, and select Displays the EPSON Scan Setup Screen.

Click the [2] Scan icon and select any detailed scan settings you want to use from the Epson Scan 2
window.

Click Scan.
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You see a preview of your scan in the Document Capture window.

Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture
window.

8. If you would like to scan additional originals and add them to the current captured images, click the +
icon, select Acquire from Scanner, and repeat the previous steps.

9. Check the scanned images and edit them as necessary.

10. Click one of the destination icons to choose where to send your scanned files. (If you cannot see all
of the icons, click the arrow next to the icons.) Change any settings as necessary.

] - J@‘-*

Note: If you are sending the scanned image to a server or cloud destination, you need to enter your
login information. If you want to use Evernote as the destination, download the Evernote application
from the Evernote Corporation website and install it before scanning.

11. Depending on the destination you chose, click OK or Send to complete the operation.
Parent topic: Scanning with Document Capture Pro or Document Capture

Scanning in Epson Scan 2

Epson Scan 2 gives you access to basic and advanced scanning features. You can scan your document
and save the scanned image in various file formats in your operating system's Documents or My
Documents folder, or open it in your scanning program. You can preview the scanned image and select
or change settings as necessary.

1. Load your original in the product.
2. Start Epson Scan 2.
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You see this window:
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Scanner : | EPSON v]
Scan Settings : | Default Setting ]

Main Settings  Advanced Settings

Document Source : | ADF v|
[ Automatic Feeding Mode
Scanning Side : | Double-Sided v|
Decument Size : | Auto Datect v||:"{,||_&,'
Image Type : | Black & White v]
Resokuton : o
Stitch Images : | Off v|
Rotate : | 0° v]
Correct Document Skew : | Paper Skew v |
[J Add or edit pages after scanning
Skip Blank Pages : | Off v]
Detect Double Feed : | On v|
Image Format : [ poF v |
FieName : | img20190116_17044338.pdf |
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15.

16.

Note: The Document Source setting is automatically set to ADF for your product.

If you want to scan different size originals by loading them into the input slot one by one, check the
Automatic Feeding Mode checkbox and click Scan. Scanning begins as soon as you load each
original.

Note: Select Settings > Document Source Settings > Automatic Feeding Mode Timeout
(minutes) and enter a value to set the number of minutes before the scanner exits Automatic
Feeding Mode.

Note: When scanning thin paper and other originals that are likely to jam, press the I™ slow mode
button before placing the original to slow down the scanning speed (DS-C490).

Select the Scanning Side setting that matches the sides of the original that you want to scan.

Select the Document Size setting that matches the size of your original, or select Auto Detect to
have Epson Scan 2 automatically detect the size. You can select Customize to enter a custom size,
if necessary.

Click on one of the orientation icons, if applicable.

Select your original image type and how you want it scanned as the Image Type setting.
Select the Resolution setting you want to use for your scan.

Select any of the additional settings that you want to use on the Main Settings tab.

. Click the Advanced Settings tab and select any settings that you want to use.
. To see a preview of your scan with the settings you selected, click the Preview button.

Epson Scan 2 previews your original and displays the results in the Epson Scan 2 window.
Reinsert your original into the ADF.

If scanning an original in a carrier sheet or other special original, see the link at the end of this
section for other setting requirements for special documents.

Select the format in which you want to save your scanned file as the Image Format setting. If
necessary, select Options and select any desired format options.

Select Settings to modify the file name settings. Enter the file name for your scanned file in the File
Name field.

Select the location in which you want to save your scanned file as the Folder setting. If necessary,
select Select to choose an alternate folder or create a new folder.
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17. Make sure the product is in the correct scanning position for the type of original.

» For multiple sheets of standard-size originals, thin paper, or receipts, place the scanner in the
vertical path position.

&

» For special originals such as thick or long documents, passports, or plastic cards, place the
scanner in the straight path position.

&y

18. Click Scan.
The product scans your original and saves the scanned file in the location you specified.

19. If you selected the Automatic Feeding Mode setting, place your next original in the ADF for
scanning. When you finish scanning originals, click Finish.

Additional Scanning Settings - Main Settings Tab

Additional Scanning Settings - Advanced Settings Tab

Scanning Settings for Special Documents

Image Format Options
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Parent topic: Starting a Scan

Related references
Scanner Positions

Related tasks
Loading Originals in the Input Tray

Additional Scanning Settings - Main Settings Tab
You can select these additional scanning settings on the Epson Scan 2 Main Settings tab.

Stitch Images
When scanning double-sided originals, lets you lay out images from both sides of the original onto
one scanned page.

Rotate
Rotates the original image clockwise to the desired angle before scanning it. Select Auto to allow
your product to automatically rotate the image based on the orientation of the text (may take longer to
scan).

Correct Document Skew
Corrects skewed originals, image contents, or both.

Add or edit pages after scanning
Lets you add, remove, or edit the pages in a scan, including rotating pages and changing the page
order.

Note: To save multiple pages in a single file, you must select a file format that supports multiple
pages such as PDF or Multi-TIFF. If you select another file format, each scanned image or page is
saved as a separate file.

Skip Blank Pages
If the scanner detects marks from the other side of a blank page and adds the marks to the scanned
image, adjust this setting to prevent this.

Detect Double Feed
Detects a double-feed paper error in the ADF. If you are scanning an original envelope or plastic card,
select Off.

Parent topic: Scanning in Epson Scan 2
Additional Scanning Settings - Advanced Settings Tab

You can select these additional scanning settings on the Epson Scan 2 Advanced Settings tab. Not all
adjustment settings may be available, depending on other settings you have chosen.
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Remove Background
Removes the background of the originals.

Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes black and white images clearer and text recognition more accurate by separating the text from
the graphics.

Dropout
The scan will not pick up the color you select. This setting is available only if you select Grayscale or
Black & White as the Image Type setting.

Color Enhance
Enhances the shades of the color you select in the scanned image. This setting is available only if you
select Grayscale or Black & White as the Image Type setting.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Gamma
Adjusts the midtone density of the scanned image.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Edge Fill
Corrects shadowing around the edges of the image by filling the shadows with black or white.

Remove Punch Holes
Removes the shadows caused by holes on the edges of the original.

Parent topic: Scanning in Epson Scan 2
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Scanning Settings for Special Documents

You need to select specific options on the Main Settings tab in Epson Scan 2 when scanning special
originals.

Note: When using Document Capture Pro, open the Epson Scan 2 screen by clicking the Detailed
Settings button on the Scan Settings screen.

Note: When using Epson Scan Smart, open the Epson Scan 2 screen by clicking the Settings button >
Scanner Settings tab > Scan Settings.

Type of original Required settings

Envelope Select Off as the Detect Double Feed setting.

Plastic card Select Plastic Card as the Document Size setting or select
Off as the Detect Double Feed setting.

Carrier sheet If you select Auto Detect as the Document Size setting,

paper skew is automatically corrected even if the Correct
Document Skew setting is set to Off.

If you select a setting other than Auto Detect as the
Document Size setting, you can only use Contents Skew
as the Correct Document Skew setting. As paper skew is
not applied in this case, only contents skew is corrected
when you select the Paper and Contents Skew setting.

Passport/Passport carrier sheet Select Auto Detect as the Document Size setting.

You need to set this to save only the ID page of your
passport. Select Passport from the Scan Settings menu,
and select Settings as the Document Size setting. Select
Save ID page only when scanning passports on the
Document Size Settings screen.

Large originals If the Document Size list does not contain the document
size you want to scan, select Customize to create a custom
size.

Booklets Select Booklets from the Scan Settings menu (DS-C490).
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Type of original Required settings

Long paper If the Document Size list does not contain the document
size you want to scan, select Customize to create a custom
size and either select the Detect paper length checkbox if
the paper length is less than 215 inches (5461 mm), or enter
a custom Width and Length if the paper is 215 inches

(5461 mm) or longer.

Laminated cards To scan any transparent areas around the edges of the
card, select Settings as the Document Size setting and
either select the Scan laminated card checkbox or create a
custom size.

Parent topic: Scanning in Epson Scan 2
Image Format Options

You can select different image formats and related options. For details on available options, click the ?
icon on the Epson Scan 2 Image Format Options window. Not all image formats have options.

BITMAP (*.bmp)
A standard image file format for most Windows programs.

JPEG (*.jpg) . _ _ _
An image format that lets you highly compress image data. However, the higher the compression, the
lower the image quality. (The TIFF format is recommended when you need to modify or retouch your
scanned image.)

PNG (*.png)
An image format that does not lose quality during editing.

TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP
software.

Multi-TIFF (*.tif)
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images
using a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file.
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Searchable PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file. Recognized text in the scanned
document can be searched.

Parent topic: Scanning in Epson Scan 2

Scan Resolution Guidelines

The resolution setting in your scanning software, measured in dpi (dots per inch), controls the amount of
detail captured in your scans. Increasing the resolution raises the amount of detail captured but comes
with the following disadvantages:

» Larger file sizes
+ It takes longer to scan your originals, send/receive your scans by email or fax, and to print your scans
* The image may become too large to fit on your display or print on paper

If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the
resolution from the default resolution set by the software. Follow these guidelines to determine the
resolution setting you need:

* You will scan the image at its original size but enlarge it later in an image-editing program.

Increase the resolution setting in your scanning software. Increase the resolution by the same amount
you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi
(dots per inch) and you will double the image size later, change the resolution setting to 600 dpi.

* You will scan the image at 100% or smaller size.
Select the resolution setting based on how you will use the scanned image:
» Email/view on a computer screen/post on the web: 96 to 200 dpi
 Print/fax/convert to editable text (OCR)/create searchable PDF: 200 to 300 dpi
Parent topic: Starting a Scan

Scanning Special Projects

Your product's scanning software offers various options to help you quickly complete special scan
projects.

Scanning Two Originals onto One Sheet (Stitching Images) - Windows

Scanning Multi-Page Originals as Separate Files - Windows

Saving Scanned Documents as a Searchable PDF Using Epson Scan 2

Saving a Scan as an Office Format File - Windows
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Saving a Scan as an Office Format File - Mac
Scanning to a SharePoint Server or Cloud Service - Windows
Scanning to a SharePoint Server or Cloud Service - Mac

Parent topic: Starting a Scan
Scanning Two Originals onto One Sheet (Stitching Images) - Windows

You can scan both sides of a double-sided or folded original in Document Capture Pro and combine
them into a single image with the Epson Scan 2 Stitch Images setting (not available for all products).

Note: Settings may vary depending on the software version you are using. Click the Help icon in
Document Capture Pro at any time for more information.

1. Load your original in the product.

Note: Use an optional carrier sheet when scanning a folded original or damage to the original may
occur. Place the original into the carrier sheet with the folded edge against the right side of the
carrier sheet. Make sure to insert the carrier sheet into your product with the white edge facing down.

2. Do one of the following to start Document Capture Pro:

* Windows 11: Click , then search for Document Capture Pro and select it.

* Windows 10: Click E and select Epson Software > Document Capture Pro.
+ Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

* Windows (other versions): Click E" or Start and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

3. Select the Simple Scan tab.
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You see a window like this:
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Click Scan Settings > Detailed Settings.
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You see an Epson Scan 2 window like this:

E Epson Scan 2 - o

Scanner : |EPSU\I

Scan Settings : | Default Setting

Main Settings  Advanced Settings

Document Source : | ADF v|
[ Automatic Feeding Mode

Scanning Side : | Double-Sided |

Document Size : | Auto Detect ~| I |i‘5

Image Type : | Black & White v]

Resoluton o

Stitch Images : | Off v|

Rotate : | 0° v|

Correct Document Skew : | Paper Skew v|
[J Add or edit pages after scanning

Skip Blank Pages : | Off v|

Detect Double Feed : | On v|

Image Format : |p|;|:

FieName : | img20150116_17044938.pdf

Folder : |Dm.lmnﬁ
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5. Select Double-Sided as the Scanning Side setting.
Select the original document size or Auto Detect as the Document Size setting.
Select one of the following as the Stitch Images setting:
* Top & Bottom: Places the scanned images one above the other.
» Left & Right: Places the scanned images side by side.
8. Select the Advanced Settings tab and verify that the Edge Fill setting is set to None.
9. Click Save.
10. Click OK.
11. Click SCAN double-sided.

Your product scans the original and the image appears in the Edit Scanned Results window.

Note: If the scanned images are not stitched together in the correct orientation, click Scanning Side
on the Epson Scan 2 window, select Settings, set the Binding Edge to Left or Top, and rescan the
document.

12. Review and edit the scanned pages as necessary and click Next when you are finished.
13. Select a destination and any settings as necessary and click Complete.
Parent topic: Scanning Special Projects

Scanning Multi-Page Originals as Separate Files - Windows

You can use Document Capture Pro to scan multi-page originals as separate scanned files. You can
indicate how the separate files are created by defining a maximum page count per file or by inserting
blank pages, barcodes, or characters that can be detected by the software as separation markers.

Note: Settings may vary depending on the software version you are using. Click the Help icon in
Document Capture Pro at any time for more information.

1. Load your multi-page original in the product.
2. Do one of the following to start Document Capture Pro:

* Windows 11: Click , then search for Document Capture Pro and select it.

* Windows 10: Click E and select Epson Software > Document Capture Pro.
+ Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.
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* Windows (other versions): Click H or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window.
3. Select the Job Scan tab.
You see a window like this:

Document Capture Pro — - ] o 5
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4. Click the Job Settings button.
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You see a window like this:
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Select New Job and select the scan settings. Click Next when finished.
You see a window like this:
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6. Select the Apply job separation checkbox.

7. Select the method you want to use to separate the originals as the Separator setting. Click
Separation Settings to specify the settings for the selected option.

8. Finish creating the new scan job and click Save.
Click Back on the Job Settings screen.
Your originals are saved into separate files and folders as specified when the job is run.
Parent topic: Scanning Special Projects
Saving Scanned Documents as a Searchable PDF Using Epson Scan 2

You can scan a document and save the text in a searchable PDF. In a searchable PDF, text is
recognized using Optical Character Recognition (OCR) and then embedded in the scanned original.

Note: The required Epson Scan 2 OCR Component is installed automatically when you install your
product software. If you install your product software programs individually, be sure to also install this
component if you want to perform OCR.

Load your original in the product for scanning.

Start Epson Scan 2.

Select your scan settings.

Click Preview and adjust the area you want to scan, if necessary.
Reload the ejected original in the scanner.

Select Searchable PDF as the Image Format setting.

No o bk owhd =

Select Options from the Image Format list.
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You see this window:
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8. Select any of the options on the General tab.
9. Select the Text tab.
10. Make sure the language used in the document text is selected as the Text Language setting.

11. Select the Security tab if you want to add a password to the PDF or protect printing or editing
properties.

12. Click OK.
13. Confirm the File Name setting and select a Folder setting for your document.
14. Click Scan.
The scanned image is saved as a searchable PDF.
Parent topic: Scanning Special Projects
Saving a Scan as an Office Format File - Windows

You can use Document Capture Pro (Windows) to save your scans in one of the following Microsoft
Office file formats: Microsoft Word (.docx), Microsoft Excel (.xIsx), or Microsoft PowerPoint (.pptx).
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Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:

* Windows 11: Click , then search for Document Capture Pro and select it.

* Windows 10: Click E and select Epson Software > Document Capture Pro.
+ Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.
* Windows (other versions): Click H or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.
3. Select the Simple Scan tab.
You see a window like this:

[ ———
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4. If you want to select specific scan settings for the scan, click the Scan Settings button, select any
displayed settings you want to use, and click OK.

Note: See the help information in Document Capture Pro for details.
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5. Do one of the following:
» To scan the front side of an original, select SCAN single-sided.
» To scan both sides of an original,select SCAN double-sided.
Your product starts scanning and you see the Edit Scanned Results window.
6. View and edit the scanned pages as necessary and click Next when you are finished.

Note: See the help information in Document Capture Pro for details.

7. Click one of the destination icons (except Print) to choose where to send your scanned files. You
see the settings window.

8. Select the Office format file you want to use from the File Type drop-down list.
9. Click Option to display additional settings.
10. Select any additional settings as necessary and click OK.

Note: See the help information in Document Capture Pro for details.

11. Confirm your settings and click Complete.
Your originals are saved in the Office file format you selected.
Parent topic: Scanning Special Projects
Saving a Scan as an Office Format File - Mac

You can use Document Capture (Mac) to save your scans in one of these Microsoft Office file fomats:
Microsoft Word (.docx) and Microsoft Excel (.xlIsx).

Note: The settings may vary, depending on the software version you are using. See the Help information
in Document Capture for details.

1. Load your original in the product for scanning.
2. Open the Applications folder, open the Epson Software folder, and select Document Capture.
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You see a window like this:
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Note: You may need to select your scanner from the scanner list.

Click the E' Scan icon.
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You see a window like this:

a Scan Settings

Scanner: EPSON
Source:  ADF
Double-Sided
Document Size:  Letter

e

Image Type: Auto
Rotation:  Mone
Resolution: Low H
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Text Enhancement

Correct Documaent Skew
Skip Blank Page

Show the confirmation dialog after scanning

? Cancel | L

Note: If you want to use a scan job that you created instead, select it from the Job list in the
Document Capture window, click the 22| Start Job button, and skip the rest of these steps.

Select any displayed scan settings you want to use.
Note: See the Help information in Document Capture for details.

If you want to select detailed scan settings, close the Scan Settings window, open the Scan menu at
the top of the Mac desktop, and select Displays the EPSON Scan Setup Screen.

Click the [2] Scan icon and select any detailed scan settings you want to use from the Epson Scan 2
window.

Click Scan.

127



You see a preview of your scan in the Document Capture window.
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Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture
window.

8. If you would like to scan additional originals and add them to the current captured images, click the +
icon, select Acquire from Scanner, and repeat the previous steps.

9. Check the scanned images and edit them as necessary.
10. Open the File menu at the top of the Mac desktop and select Save As.
11. Select DOCX (Word) or XLSX (Excel) as the File Type setting.

Note: The first time you select an Office file type setting in Document Capture, you see a prompt to
download a necessary plug-in for Microsoft Office files. Select Yes and follow the on-screen
instructions to download and install the plug-in to continue.

12. Click the Options button, select any necessary Office file type options, and click OK.
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13. Click one of the Destination icons to choose where to send your scanned file. (If you cannot see all
of the icons below, click the arrow next to the icons.)

| - J@‘-*

14. Depending on the destination you chose, click OK or Send to complete the operation.
Parent topic: Scanning Special Projects
Scanning to a SharePoint Server or Cloud Service - Windows

You can use Document Capture Pro (Windows) to upload scanned images to a SharePoint server or a
cloud service.

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:

* Windows 11: Click , then search for Document Capture Pro and select it.

* Windows 10: Click E and select Epson Software > Document Capture Pro.
+ Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

3. Select the Simple Scan tab.
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You see a window like this:

Document Capture Pro
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If you want to select specific scan settings for the scan, click the Scan Settings button, select any
displayed settings you want to use, and click OK.

Note: See the help information in Document Capture Pro for details.

Do one of the following:

» To scan both sides of an original,select SCAN double-sided.

* To scan the front side of an original, select SCAN single-sided.

Your product starts scanning and you see the Edit Scanned Results window.

View and edit the scanned pages as necessary and click Complete when you are finished.

Note: See the help information in Document Capture Pro for details.

Click one of the cloud server or service destination icons. You see the settings window.

Enter any required information to set up the destination. You may need to log in to your cloud service
to authenticate the connection and allow Document Capture Pro to access the cloud service.
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9. Adjust any settings and click Complete.
Note: See the help information in Document Capture Pro for details.

Your originals are uploaded to the indicated server or cloud service.
Parent topic: Scanning Special Projects
Scanning to a SharePoint Server or Cloud Service - Mac
You can use Document Capture to upload scanned images to a SharePoint server or a cloud service.

Note: The screen shown may vary, depending on your OS version.

1. Open the Applications folder, open the Epson Software folder, and select Document Capture.
You see a window like this:
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Note: You may need to select your product from the drop-down list.

2. Click the 2] scan icon.
3. Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture for details.
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4. Click Scan.
You see a preview of your scan in the Document Capture window.

5. Click one of the cloud service Destination icons to choose where to save your scanned file. (If you
cannot see all of the icons, the service software may not be installed, the service may not be
available on your platform, or you need to click the arrow next to the icons.)

You see the Transfer Settings window.

6. Enter any required information to set up the destination. You may need to log in to your cloud service
to authenticate the connection and allow Document Capture to access the cloud service. If you have
previously created a saved setting for the destination, select it from the drop-down list.

7. Adjust any save settings, then click OK or Send, depending on the destination.
Your originals are scanned and uploaded to the indicated server or cloud service.
Parent topic: Scanning Special Projects
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Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.

Cleaning Your Product
Cleaning Inside Your Product
Replacing the Rollers
Transporting Your Product

Cleaning Your Product
To keep your product working at its best, you should clean it several times a year.
Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.

Do not use oil or other lubricants inside the product or let water get inside it. Do not open the product's
outer case.

Turn off the scanner and unplug the AC adapter.
Disconnect any connected cables.
3. Clean the outer case with a soft, dry cloth. Do not use liquid or chemical cleansers.

Note: If the outer case still requires additional cleaning, use a slightly damp cloth to wipe the outer
case. Then wipe the case with a soft, dry cloth.

Parent topic: Cleaning and Transporting Your Product

Cleaning Inside Your Product

Clean your product regularly to make sure that no dust builds up on the glass scanning surfaces. Dust
can cause spots or lines in your scanned images. Clean the inside of the product every 5,000 scans. You
can check the latest number of scans and set cleaning time notifications and alerts in the Epson Scan 2
Utility. By default, a notification is sent after every 5,000 scans.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it. Do not open the product's
outer case.
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Caution: Be careful not to get your hands or hair caught in the gears or rollers when cleaning the inside
the scanner. Otherwise, injury could occur.

Note: Clean inside your product while it is turned on.

1. Open the vertical path cover.

Note: When opening the vertical path cover, hold the area indicated to avoid touching the antistatic
brush. If the brush becomes bent it cannot eliminate static electricity, and this may cause the output
originals to stick to each other.
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2. Wipe the rollers and plastic rollers with a soft, lint-free cloth dampened with a small amount of

cleaner or water.

4 N 4 N

— — [ —— i ) R
THCH HH

Y

N\

\ J J
-\
O ——

Note: Do not spray liquid directly into the scanner. Be careful not to touch the antistatic brush when
wiping the rollers. If the brush becomes bent it cannot eliminate static electricity, and this may cause

the output originals to stick to each other.

3. Open the input tray, and pull the lever to open the scanner cover.
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4. Wipe the 8 rollers shown with a soft, lint-free cloth dampened with a small amount of cleaner or
water.

Note: Do not spray liquid directly into the scanner.
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5. Close the scanner cover with both hands. Then, close the vertical path cover and then the input tray,
in that order.
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After closing the cover, wait for approximately four seconds before proceeding to the next step.

6. Repeat steps 1 to 5 four times. The internal rollers rotate approximately one-quarter of a turn each
time the cover is closed. Repeat this step until the entire roller is clean.

Note: If paper dust adheres to the inside of the vertical path cover, wipe it off with a soft, lint-free
cloth.
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7. Open the input tray, and pull the lever to open the scanner cover.

8. Use a genuine Epson cleaning kit or a soft, lint-free cloth to wipe off any dust or dirt on the glass
scanning surfaces and the rollers inside the scanner cover. If the glass surface is stained with
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grease or some other hard-to-remove material, use a genuine Epson cleaning kit with a small
amount of cleaner on the cleaning cloth to remove the stains. Wipe off all remaining liquid.

Caution: Do not use brushes or hard tools to clean the scanner glass. Any scratches on the glass
may affect the scan quality. Do not spray cleaner directly on the scanning surfaces. Be careful not to
place too much force on the glass.

Use a cotton swab to wipe off any dust or dirt on the sensors shown here.
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Caution: Do not use liquid or glass cleaner on the cotton swab.

Note: The ultrasonic sensors do not normally require maintenance. However, if multiple feed errors
occur frequently, it is possible that dust that has accumulated around the ultrasonic sensors is being
mistakenly detected as a multiple feed error. If this is the case, carefully wipe away any dust with a
cotton swab. If you have a blower, such as one used to clean cameras, use it to remove the dust.

Do not spray cleaner directly onto the ultrasonic sensor. Also, be careful not to insert the cotton
swab too far into the sensor and make sure no cotton fibers are left behind.
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10. Open the cover and remove the separation roller.

11. Wipe off any dust or dirt on the separation roller using a genuine Epson cleaning kit or a soft, moist
cloth.

Caution: Use only a genuine Epson cleaning kit or soft, moist cloth to clean the roller; using a dry
cloth may damage the surface of the roller. Do not spray cleaners directly inside the product; always
spray cleaners on a cleaning cloth to slightly dampen the cloth. Wipe off any excess cleaner with a
dry, lint-free cloth.
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12. Replace the separation roller.
13. Open the cover, then remove the pickup roller.

4 )

14. Wipe off any dust or dirt on the pickup roller using a genuine Epson cleaning kit or a soft, moist cloth.

Caution: Use only a genuine Epson cleaning kit or soft, moist cloth to clean the roller; using a dry
cloth may damage the surface of the roller.
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15. Replace the pickup roller.
16. Close the scanner cover with both hands. Then, close the input tray.

17. Reset the number of scans after cleaning.
Resetting the Number of Scans After Cleaning
Parent topic: Cleaning and Transporting Your Product

Related references
Optional Accessories and Replacement Parts

Related tasks
Replacing the Rollers

143



Resetting the Number of Scans After Cleaning
Reset the number of scans using the Epson Scan2 Utility after regular cleaning.

1.
2.

Make sure the scanner is turned on and connected to your computer.

Do one of the following to open the Epson Scan 2 Utility:

* Windows 11: Click , then search for Epson Scan 2 Utility and select it.

* Windows 10: Click E and select EPSON > Epson Scan 2 Utility.

+ Windows 8.x: Navigate to the Apps screen and select EPSON > Epson Scan 2 Utility.

* Windows (other versions): Click e or Start > All Programs or Programs > EPSON > Epson
Scan 2 > Epson Scan 2 Utility.

* Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility.
Click the Maintenance tab.
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You see a screen like this:

E Epson Scan 2 Utility b
Coannes : .EP'EK'.‘N ""._

Information Counter Power Save Mantenance Aductments Scanner Settng  Other

Regular Cleaning
B Ragusr Claarang Kert
Swrnbar of Scans : [o ' Resat
Count Mlert Setting : 10000 | = Lt
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4. Selectthe Regular Cleaning Alert checkbox and click the Reset button.
Note: You cannot reset if Regular Cleaning Alert is not selected.

5. Close the Epson Scan 2 Utility.
Parent topic: Cleaning Inside Your Product
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Replacing the Rollers

Replace the roller assembly kit (A: separation roller, B: pickup roller) when the number of scans exceeds
the life cycle of the rollers. Check the roller counter to see when you need to replace the rollers.

Note: Replace the rollers while the scanner is turned on.

1. Open the input tray, and pull the lever to the right to open the scanner cover.

146



2. Press down on the separation roller cover latch and pull up the cover to remove it.
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3. Lift up the separation roller and slide it to the left to remove it.

Note: Do not use force to pull out the separation roller; doing so may damage the inside of the
product.
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4. Toinstall a new separation roller, insert the end of the roller into the hole on the right side and lower
the other end of the roller into place.
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5. Attach the separation roller cover as shown. Insert the axis on the upper side of the cover into the
grooves, and then close the cover firmly.
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Note: If you are not able to close the cover, the roller is not installed correctly. Remove the roller and
reinstall it, then try to close the cover again.

e p

e

‘ ./
Y (T
0SS |

151



7. Slide the pickup roller to the right and lift up to remove it.
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8. Toinstall the new pickup roller, align the notches on the roller unit and slide it to the left. Lower the
pickup roller, and then slide it to the back. Make sure the notches are aligned.
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9. Align the bottom edge of the pickup roller cover into the notches as shown and press it down until it
clicks into place.
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Note: If you are not able to close the cover, the pickup roller is not installed correctly. Remove the
roller unit and reinstall it, then try to close the cover again.
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10. Close the scanner cover with both hands, then close the input tray.

11. Reset the roller counter.

Note: Make sure to dispose of the pickup roller and the separation roller following the rules and
regulations of your local authority. Do not disassemble them.

Resetting the Roller Counter
Parent topic: Cleaning and Transporting Your Product

Related references
Optional Accessories and Replacement Parts
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Resetting the Roller Counter

When you replace the scanner rollers, reset the scanner roller counter so you know when you may need
to replace the rollers again.

1. Make sure the scanner is turned on and connected to your computer.
2. Do one of the following to open the Epson Scan 2 Utility:

* Windows 11: Click , then search for Epson Scan 2 Utility and select it.
* Windows 10: Click E and select EPSON > Epson Scan 2 Utility.
+ Windows 8.x: Navigate to the Apps screen and select EPSON > Epson Scan 2 Utility.

* Windows (other versions): Click e or Start > All Programs or Programs > EPSON > Epson
Scan 2 > Epson Scan 2 Utility.

* Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility.
3. Click the Counter tab.
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You see a screen like this:

B Epzon Scan 2 Utility E
Seanver : | EPSON |
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Double-Sded : O
Carmer Sheet; O
Passport Carrier Shest : Mo Informaton
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Paper lam: O
Double Feed : O
Paper Protecton: 0
Roler Assembly Kit
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4. Click Reset under Roller Assembly Kit.

The Number of Scans field changes to 0 (zero).
5. Close the Epson Scan 2 Utility.
Parent topic: Replacing the Rollers

Transporting Your Product

If you need to ship your product, transport it a long distance, or store it for an extended period, prepare it
for transportation as described here.

1. Turn off the product and unplug the AC adapter.
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2. Disconnect any connected cables.
3. Close the input tray extension and the input tray.

Note: Make sure the output tray paper support is securely closed.

4. Pull the position selector on the back of the product to the right, and tilt the scanner forward into the
vertical path position.

&

5. Place the product in its original packing materials, if possible, or use equivalent materials with
cushioning around the product.
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If you need to move the scanner, carry it as shown here.
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Note: Make sure to disconnect all cables, stow the input and output tray paper supports, and place the
scanner in the vertical path position.

r

Parent topic: Cleaning and Transporting Your Product
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Solving Problems

Check these sections for solutions to problems you may have using your product.

Note: Your product may differ from the images in this guide, but the instructions are the same unless

otherwise noted.

Scanner Light Status
Solving Scanning Problems

Solving Scanned Image Quality Problems
Updating Applications and Firmware
Resetting the Epson Scan 2 Settings
Uninstall Your Product Software

Where to Get Help (U.S. and Canada)
Where to Get Help (Latin America)

Scanner Light Status

The lights on the scanner indicate the scanner status and let you know when a problem occurs. Check
the status of the lights and look for a solution in the table here.

Light status

Condition/solution

The ! error light is flashing

A paper jam or a double feed has occurred. Open the scanner cover
and remove any jammed originals. Close the scanner cover to clear the
error and load the originals again.

This product uses two different positions for scanning, depending on the
original being scanned. Check the link at the end of this section to see
which position is appropriate for your original.

The 1 error light is on

The scanner cover is open. Make sure the scanner cover is closed and
there is no jammed paper inside.

The -’E scanner position light

is flashing and the I error light
ison

The scanner position was changed during scanning. Open the scanner
cover, remove the original, and return the scanner to its original
position.
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Light status Condition/solution

The scanner position has not been set. Set the scanner in the vertical

The #= scanner position light path position or straight path position.

is flashing quickly
The following lights are A fatal error has occurred. Try the following:
flashing quickly: » Check the scanner connection to your computer to make sure it is
QO ready secure.

i N * Turn the scanner off and then back on again. If the error continues,
* #Z scanner position the scanner may be malfunctioning. Contact Epson for support.
. !error

« ™ slow mode (DS-C490)

The U ready light is off and The firmware update has failed and the scanner is in recovery mode.
the following lights are on: Try the following:

i - + Make sure the USB cable is connected between your scanner and
* *= scanner position computer. (During recovery mode, you cannot update the firmware
1 over a network connection.)
* s error

* Try updating the firmware again.

« I™ siow mode (DS-C490)

Parent topic: Solving Problems

Related references

Where to Get Help (U.S. and Canada)
Where to Get Help (Latin America)
Scanner Positions

Related tasks
Replacing the Rollers
Cleaning Inside Your Product

Solving Scanning Problems
Check these solutions if you have problems scanning with your product.

Product Does Not Turn On or Turns Off Unexpectedly
Scanner Button Does Not Work as Expected
Scanning Software Does Not Operate Correctly
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Cannot Start Epson Scan 2

Cannot Start Document Capture Pro (Windows) or Document Capture (Mac)
Paper Feeding Problems

Paper Jam Problems

Paper Protection Does Not Work Correctly

Scanning is Slow

Parent topic: Solving Problems

Product Does Not Turn On or Turns Off Unexpectedly
If the product does not turn on or if it turns off unexpectedly, try these solutions:
* Make sure the AC adapter is securely connected to the product and to a working electrical outlet.

« If the product turns off unexpectedly, you may need to adjust the Sleep Timer and Power Off Timer
settings in the Epson Scan 2 Utility.

Parent topic: Solving Scanning Problems

Related tasks
Changing the Power Off and Sleep Timer Settings

Scanner Button Does Not Work as Expected
If the scanner button does not start the correct program or perform the correct action, try these solutions:
» Make sure your scanner is turned on and any interface cables are securely connected at both ends.
» Check the USB cable connection between the computer and scanner if you are connecting via USB.
» Check that the correct scanner is selected using the Epson Scan 2 Utility.
* In Windows, be sure that the scanner is listed under Imaging Devices in the Device Manager.

* Make sure Document Capture Pro (Windows) or Document Capture (Mac) is installed correctly. If
necessary, uninstall and reinstall it.

» Check the status of the lights and make sure the scanner is ready to scan.

* If you are connecting your scanner via USB, use only the USB cable that came with the scanner.
Make sure it is connected directly to your computer and not to a USB hub.

* Make sure Epson Scan 2 and other applications are installed correctly. If necessary, uninstall and
reinstall it.

Parent topic: Solving Scanning Problems
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Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:

Make sure your computer has adequate memory and meets the system requirements for your
operating system.

Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,
wake your system and restart your scanning software.

Make sure the product is turned on.

Make sure the scanning software is installed.

Make sure the connection between the product and your computer is secure.

If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.
In Windows, be sure that the product is listed under Imaging Devices in the Device Manager.
Check that the correct product is selected using the Epson Scan 2 Utility.

Check that the correct setting is assigned to the scanner button in Document Capture Pro (Windows)
or Document Capture (Mac).

Connect the product directly to the computer. The product may not work properly when connected
through a USB hub/switch.

Document Capture Pro (Windows) does not support Windows Vista or Windows Server, so use Epson
Scan 2 for scanning instead.

If you are using a TWAIN-compliant program, make sure that the correct product is selected as the
Scanner or Source setting.

Parent topic: Solving Scanning Problems

Related concepts
Uninstall Your Product Software

Related references
Windows System Requirements
Mac System Requirements

Cannot Start Epson Scan 2

If you cannot start Epson Scan 2, try these solutions:

Make sure your scanner appears in the Epson Scan 2 Utility.
Make sure to use the USB cable that came with the scanner.
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* Make sure your scanner is turned on and any interface cables are securely connected at both ends.

* Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,
wake your system and restart Epson Scan 2.

» Connect the scanner directly to the computer. The scanner may not work properly when connected
through a USB hub.

+ If you upgraded your operating system but did not reinstall Epson Scan 2, try reinstalling it.

+ If you are using a TWAIN-compliant program, make sure that the correct product is selected as the
Scanner or Source setting.

» Make sure the ready light stops flashing, indicating that the scanner is ready to scan.
Parent topic: Solving Scanning Problems

Cannot Start Document Capture Pro (Windows) or Document Capture (Mac)
If you cannot start Document Capture Pro (Windows) or Document Capture (Mac), try these solutions:

* Make sure Document Capture Pro (Windows) or Document Capture (Mac), Epson Scan 2, and Epson
Event Manager are installed.

» Make sure the correct setting is assigned to the scanner button in Document Capture Pro (Windows)
or Document Capture (Mac).

* Make sure to use the USB cable that came with the scanner.
» Make sure your scanner is turned on and any interface cables are securely connected at both ends.

» Connect the scanner directly to the computer. The scanner may not work properly when connected
through a USB hub.

+ If you upgraded your operating system but did not reinstall Document Capture Pro, try reinstalling it.
* Make sure the status light stops flashing, indicating that the scanner is ready to scan.
Parent topic: Solving Scanning Problems

Paper Feeding Problems
If you have problems feeding originals in your product, try these solutions:

« Ifthere is a jammed original inside the scanner, open the scanner cover or vertical path cover and
remove the original.
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» Make sure the scanner is in the correct position for the type of original being scanned. See the link at
the end of this section to see which position is appropriate for your original.

* When scanning multiple standard-size originals, scan in the vertical path position. If the scanner is
in the straight path position, pull the scanner position selector to the right and tilt the scanner
forward to place it in the vertical path position.

&

* When scanning in the straight path position, load only one original at a time. If the scanner is in the
vertical path position, pull the scanner position selector to the right and tilt the scanner backward to
place it in the straight path position.

&

« If multiple pages feed at once, try the following:
* Remove the originals, fan the edges to separate the sheets, if necessary, and reload them.

* Load fewer originals at a time.
* Load only originals that meet the specifications for your product.
+ Press the 1™ slow mode button to slow down the scanning speed (DS-C490).
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Clean inside the product and clean the rollers. If the rollers were previously removed for cleaning,
make sure they were properly reinstalled.

Check the number of sheets scanned by the pickup roller. If the number of scans exceeds the
pickup roller's service life (50,000 sheets), replace the roller assembly kit with a new one. Even if the
number of scans does not exceed the pickup roller's service life, we recommend replacing the roller
assembly kit with a new one if the surface of the roller is worn out.

Note: You can check the number of sheets scanned by the pickup roller in the Epson Scan 2 Utility.
Start the Epson Scan 2 Utility, click the Counter tab, and then check the Number of Scans under
Roller Assembly Kit.

If multiple feed errors occur frequently, it is possible that dust or dirt that has accumulated around
the ultrasonic sensors is being mistakenly detected as a multiple feed error. If dust has accumulated
around the ultrasonic sensors, clean the ultrasonic sensors.

Use Automatic Feeding Mode in Epson Scan 2 and scan originals one at a time.

If you see a double feed error in the Epson Scan 2 window or the Document Capture Pro window
(Windows only), start Epson Scan 2, select the Main Settings tab, select the Detect Double Feed
setting, and select Off.

Note: On a Mac, only Epson Scan 2 displays double feed errors. Document Capture for Mac does
not include this setting.

Parent topic: Solving Scanning Problems

Related references

Optional Accessories and Replacement Parts
Original Document Specifications

Plastic and Laminated Card Specifications
Special Original Specifications

Scanner Positions

Related tasks

Cleaning Inside Your Product

Related topics
Loading Originals
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Paper Jam Problems
If an original is jammed in the scanner, clear the jam according to the procedure for the scanner position.

Note: Do not change the scanner position while scanning, otherwise the original will get jammed.

Vertical Path Position

1. Turn off your product.

2. Remove all originals from the input tray.
3. Open the vertical path cover.
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4. Pull down the cover open lever and open the scanner cover.
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6. If you cannot pull originals straight up, carefully pull out any jammed originals from the output tray in
the direction of the arrow.

Note: Make sure there is no paper inside the scanner.
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7. Close the scanner cover with both hands. Then, close the vertical path cover.
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Caution: Before restarting scanning, make sure that the scanner is stationary. If the scanner is not
stationary, it could cause the original to jam.

8. Carefully follow all loading instructions when you reload originals.

Straight Path Position
1. Turn off your product.
2. Remove all originals from the input tray.
3. Pull the lever to open the scanner cover.
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4. Gently pull out any jammed originals from inside the product.

5. If you cannot pull originals straight up, carefully pull out any jammed originals from the output slot in
the direction of the arrow.
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Note: Make sure there is no paper inside the scanner.

6. Close the scanner cover with both hands.

Important: Before restarting scanning, make sure that the scanner is stationary. If the scanner is not
stationary, it could cause the original to jam.

7. Carefully follow all loading instructions when you reload originals.
If originals jam in the product frequently, try the following:
» For originals with folds or that are curled, flatten the original before loading.
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» When loading originals with a mixture of different sizes, load the originals with the side to be scanned
facing up and in descending order of paper size with the widest at the back and the narrowest at the
center of the input tray. Next, slide the edge guides to align them with the widest originals.

— |
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If the problem is not solved, try scanning the originals at each size separately, or scan the originals
one by one. Align the edge guides to the width of the originals each time you load them.

+ Press the 1™ slow mode button to slow down the scanning speed (DS-C490).

+ Clean inside the product and clean the rollers. If the rollers were previously removed for cleaning,
make sure they were properly reinstalled.

» Check the number of sheets scanned by the pickup roller. If the number of scans exceeds the pickup
roller's service life (50,000 sheets), replace the roller assembly kit with a new one. Even if the number
of scans does not exceed the pickup roller's service life, we recommend replacing the roller assembly
kit with a new one if the surface of the roller is worn out.

Note: You can check the number of sheets scanned by the pickup roller in the Epson Scan 2 Utility.
Start the Epson Scan 2 Utility, click the Counter tab, and then check the Number of Scans under
Roller Assembly Kit.

+ After scanning, remove the original from the output tray or the output slot.
Parent topic: Solving Scanning Problems
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Related references

Original Document Specifications

Plastic and Laminated Card Specifications
Special Original Specifications

Scanner Positions

Where to Get Help (U.S. and Canada)
Where to Get Help (Latin America)

Related tasks
Cleaning Inside Your Product

Related topics
Loading Originals

Paper Protection Does Not Work Correctly

To reduce damage to the original, the Paper Protection feature immediately stops scanning if a paper
feed error is detected. If the Paper Protection feature does not work correctly, try these solutions:

 If your scanned original is damaged, make sure that the Paper Protection feature is enabled. Increase
the detection level, if necessary.

« If misdetection occurs frequently, lower the Paper Protection detection level in the Epson Scan 2 Utility
(On-Medium is the default).

» Turn the Paper Protection feature off in the Epson Scan 2 Utility (Scanner Setting > Paper
Protection > Off).

Note: Set the Paper Protection feature to Off when scanning plastic cards and thick originals.

* Make sure the sensors are clear of paper dust and debris.

* When scanning multiple originals, make sure that the leading edges of the documents are aligned. If
the leading edges of the documents are not aligned, they may be mistakenly detected as a paper feed
error even if they are scanned correctly.

* Make sure you align the edge guides with the original to avoid scanning at an angle.
Parent topic: Solving Scanning Problems
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Scanning is Slow
If scanning becomes slow, try these solutions:

Scan your original at a lower resolution, if possible.

Make sure your system meets the requirements for your operating system. If you are scanning a high-
resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory or reduce the resolution.

Make sure you did not press the 1™ slow mode button to slow down the scanning speed (DS-C490).
The scanning speed may be reduced depending on the image adjustment features in Epson Scan 2.

If scanning becomes slower after scanning continuously with the ADF for a long time, the scanner may
have automatically slowed down to protect the scanner mechanism from overheating or becoming
damaged. Let the scanner rest with the power on for 30 minutes, then try scanning again.

If you are running virus protection or other security software, exclude the TWAIN.log files from
monitoring or set the TWAIN.log file as read only. See your virus protection or security software
instructions for details. The TWAIN.log file is saved in C:\Users\(user name)\AppData\Local\Temp.

Note: You may need to unhide system folders to view files in that location.

Computers with USB 3.0 (SuperSpeed) or USB 2.0 (Hi-Speed) ports can scan faster than those with
USB 1.1 ports. If you are using a USB 3.0 or 2.0 port with the scanner, make sure it meets the system
requirements.

Parent topic: Solving Scanning Problems

Related references
Windows System Requirements
Mac System Requirements

Solving Scanned Image Quality Problems
Check these sections if a scanned image on your computer screen has a quality problem.

Note: For solutions when using Document Capture Pro (Windows) or Document Capture (Mac)
software, see the Document Capture Pro (Windows) or Document Capture (Mac) help utility.

Back of Original Image Appears in Scanned Image
Scanned Characters are Blurry
Characters are not Recognized During Conversion to Editable Text (OCR)
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Ripple Patterns Appear in an Image

Uneven Colors Appear in Scanned Image
Spots or Lines Appear in All Scanned Images
Scanned Image is Cropped

Cannot Solve Problems in the Scanned Image

Parent topic: Solving Problems

Back of Original Image Appears in Scanned Image

If an image from the back of a thin original appears in your scanned image, make sure you selected the
correct Image Type setting for your original and select the Text Enhancement setting in Epson Scan 2.
You can also select the Remove Background setting in Epson Scan 2.

Note: If you select Color as the Image Type setting, you can change the level from Standard to High to
remove more of the background.

If the image is still visible, you can also try setting a lower level for Edge Enhancement or a higher level
for Noise Reduction.

Parent topic: Solving Scanned Image Quality Problems

Related references
Image Format Options

Related tasks
Scanning in Epson Scan 2

Scanned Characters are Blurry
If characters in your scanned images are blurry, try these solutions:
* Make sure you do not move the product or original while scanning.
» Operate the product on a flat, stable surface.
» Make sure the originals are ejecting properly.
+ Adjust these Epson Scan 2 settings (if available) and try scanning again:
+ Select the Text Enhancement setting.

+ Ifthe Image Type setting is Black & White, adjust the Threshold setting or click Settings and
adjust the slider for Emphasize light letters / Remove background, turn off Remove spot noise,
or set the level to Low.
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* Increase the Resolution setting.
+ Setthe Image Type to Grayscale.

+ If you are scanning in JPEG format, change the compression level. Click Options in the Image
Format menu and change the Image Quality setting.

Parent topic: Solving Scanned Image Quality Problems

Related references
Image Format Options

Related tasks
Scanning in Epson Scan 2

Characters are not Recognized During Conversion to Editable Text (OCR)
If characters in your scanned images are not recognized during OCR conversion, try these solutions:

Make sure your original is loaded straight on your product.

Use an original with clear text.

Adjust these Epson Scan 2 settings (if available) and try scanning again:
» Select the correct Image Type setting.

+ Ifthe Image Type is set to Black & White, select Text Enhancement. If the Image Type is set to
Color or Grayscale, change the Text Enhancement setting to High.

+ If the Image Type is set to Black & White, adjust the Threshold setting.

+ Setthe Image Type to Grayscale.

Set the scanning resolution between 200 and 600 dpi.

If the original document is in landscape mode, set the Rotate setting to Auto in Epson Scan 2.
If you are using OCR software, check the manual for any additional adjustments.

Scan thermal paper receipts as soon as possible. They may deteriorate due to age or friction.

When saving to Microsoft Office or Searchable PDF files, check that the correct languages are
selected. Check the language in each save setting window.

Parent topic: Solving Scanned Image Quality Problems

Related references
Image Format Options
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Related tasks
Scanning in Epson Scan 2

Ripple Patterns Appear in an Image

You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused
by interference from differing pitches in the scanner's screen and your original's halftone screen. To
reduce this effect, adjust these Epson Scan 2 settings (if available) and try scanning again:

+ Select the Descreening setting on the Advanced Settings tab.
+ Select a lower Resolution setting.
Parent topic: Solving Scanned Image Quality Problems

Related references
Image Format Options

Related tasks
Scanning in Epson Scan 2

Uneven Colors Appear in Scanned Image

If the scanner is subjected to strong light such as direct sunlight, the internal sensor misdetects the light
and colors in the scanned image become uneven.

» Change the orientation of the scanner so that strong light is not falling on the front of the scanner.
* Move the scanner to a location where it will not be subjected to strong light.
Parent topic: Solving Scanned Image Quality Problems

Spots or Lines Appear in All Scanned Images
If spots or lines appear in all your scanned images, try the following solutions:

» Clean the rollers and glass scanning surfaces inside your product using a genuine Epson cleaning kit
or a soft, moist cloth.

* Remove any dirt from your original.
» Enable the Detect Glass Dirt setting in the Epson Scan 2 Utility.

Note: If glass dirt detection does not work correctly, adjust the setting. If the glass dirt alert screen
appears after cleaning the inside of the product, check the glass surface again (scratches on the glass
may be detected as a glass dirt).
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Parent topic: Solving Scanned Image Quality Problems

Related tasks
Cleaning Inside Your Product

Scanned Image is Cropped
If the edges of a scanned image are cropped, try the following solutions:

» Select Auto Detect or Auto Detect (Long Paper) as the Document Size setting in Epson Scan 2,
Document Capture Pro, or Document Capture.

Note: DS-C330: The maximum paper length is 120 inches (3048 mm); select Customize to create a
custom paper size.

DS-C490: If the paper length is more than 120 inches (3048 mm), select Customize to create a
custom paper size. If the paper length is 215 inches (5461 mm) or less, select Detect paper length
instead of entering the paper size. If the paper is longer than 215 inches (5461 mm), enter the paper
size.

* In Epson Scan 2, select the Main Settings tab. Select Document Size > Settings and adjust the
cropping area shown in the Crop Margins for Size "Auto" setting. In Document Capture Pro, select
Detailed Settings from the Scan window. Click Configuration and select the Document tab. Adjust
the cropping area shown in the Crop Margins for Size "Auto™ setting.

* Document Capture Pro (Windows): Select Detailed Settings from the Scan window. Select
Document Size > Settings and then adjust the cropping area shown in the Crop Margins for Size
"Auto" setting.

* Document Capture (Mac): Click the @ Scan button and select Main Settings from the Scan
window. Select Document Size and then adjust the cropping area shown in the Crop Margins for
Size "Auto" setting.

Parent topic: Solving Scanned Image Quality Problems

Related tasks
Scanning in Epson Scan 2

Cannot Solve Problems in the Scanned Image

If you have tried all of the solutions and have not solved the problem, initialize the scanner driver (Epson
Scan 2) settings using Epson Scan 2 Utility.
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Note: Epson Scan 2 Utility is one of the applications supplied with the scanner software.

1. Start Epson Scan 2 Utility

* Windows 11: Click , then search for Epson Scan 2 Utility and select it.

* Windows 10: Click IEI and select EPSON > Epson Scan 2 Utility.
+ Windows 8.x: Enter the application name in the search charm, and then select the displayed icon.

* Windows 7: Click the start button, and then select All Programs or Programs > EPSON > Epson
Scan 2 > Epson Scan 2 Utility.

» Mac OS: Select Go > Applications > Epson Software > Epson Scan 2 Utility.
2. Select the Other tab.
3. Click Reset.

Note: If initialization does not solve the problem, uninstall and re-install the scanner driver (Epson
Scan 2).

Parent topic: Solving Scanned Image Quality Problems

Updating Applications and Firmware
You may be able to solve certain problems and improve or add functions by updating the applications
and firmware to the latest version.

Caution: Do not turn off the computer or the scanner while updating.

1. Make sure that the scanner and the computer are connected, and that the computer is connected to
the internet.

2. Start EPSON Software Updater and update the applications or firmware.

* Windows 11: Click , then search for EPSON Software Updater and select it.

* Windows 10: Click I:I then select Epson Software > EPSON Software Updater.
* Windows 8.x: Enter the application name in the search charm, and then select the displayed icon.

* Windows 7: Click the start button, and then select All Programs or Programs > Epson Software >
EPSON Software Updater.

* Mac OS: Select Finder > Go > Applications > Epson Software > EPSON Software Updater.
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Note: If you cannot find the application you want to update in the list, you cannot update the application
using the EPSON Software Updater. Check for the latest versions of the applications on the Epson
support website.

Updating Firmware without Connecting to the Internet

You can download the product's firmware from the Epson website on the computer, and then connect
the product and the computer via USB cable to update the firmware.

Note: Make sure Epson Scan 2 is installed on your computer. If Epson Scan 2 is not installed, download
the software from the Epson website and install it on your computer.

1. Download the latest firmware from the Epson website.

2. Connect your product to the computer using a USB cable.

3. Double-click the downloaded .exe file to start the Epson Firmware Updater.
4. Follow the on-screen instructions to update the firmware.

Parent topic: Solving Problems

Resetting the Epson Scan 2 Settings

If you continue to experience image quality problems after trying all possible solutions, you may need to
reset the Epson Scan 2 settings using the Epson Scan 2 Utility.

1. Do one of the following to start the Epson Scan 2 Utility:
* Windows 11: Click , then search for Epson Scan 2 Utility and select it.
* Windows 10: Click ﬂ > EPSON > Epson Scan 2 Utility.

* Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility.

* Windows 7: Click ﬂ and select All Programs. Select EPSON > Epson Scan 2 > Epson Scan
2 Utility.

* Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2
Utility.

Click the Other tab.
3. Click Reset and confirm your choice.
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Note: If resetting the Epson Scan 2 settings does not solve your problem, uninstall your scanner
software and re-install it.

Uninstall Your Product Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.

Uninstalling Product Software - Windows
Uninstalling Product Software - Mac

Parent topic: Solving Problems

Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.
1. Exit all applications currently running on your computer.
2. Turn off the product.
3. Disconnect any interface cables.
4. Do the following to uninstall each of your scanning software programs and follow any on-screen
instructions:

* Windows 11: Click , then search for Settings and select it. Select Apps or System > Apps &
features. Then select the program you want to uninstall and select Uninstall.

* Windows 10: Click E and select k=i (Settings) > Apps > Apps & features. Select the product
software program and click Uninstall.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the product software program and click Uninstall/Change.

* Windows 7: Open the Windows Control Panel utility. Select Programs and Features. (In
Classic view, select Programs and click Uninstall a program.) Select the product software
program and click Uninstall/Change.

5. Restart your computer, then see the Start Here sheet to re-install your software.
Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Product Software
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Uninstalling Product Software - Mac

In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

1.

o~ N

6.
7.
8.

To download the Uninstaller utility, visit epson.com/support (U.S.), epson.ca/support (Canada), or
latin.epson.com/support (Caribbean) and select your product.

Follow the instructions on the screen to install the Uninstaller utility.
Quit all applications currently running on your Mac.
Double-click the Uninstaller icon.

In the Epson Uninstaller screen, select the checkbox for each software program you want to
uninstall.

Click Uninstall.
Follow the on-screen instructions to uninstall the software.
To reinstall your product software, see the Start Here sheet for instructions.

Note: If you find that re-installing your product software does not solve a problem, contact Epson. If you
cannot find the application you want to uninstall in the application list, you cannot uninstall using the
Uninstaller. In this situation, select Go > Applications > Epson Software, select the application you
want to uninstall, and then drag it to the trash icon.

Parent topic: Uninstall Your Product Software

Where to Get Help (U.S. and Canada)

If you need to contact Epson for technical support services, use the following support options.

Internet Support

Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) and select
your product for solutions to common problems with your product. You can download utilities and
documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative

Before you call Epson for support, please have the following information ready:

* Product name

* Product serial number (located on a label on the product)
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» Proof of purchase (such as a store receipt) and date of purchase

» Computer configuration

» Description of the problem

Then call:

+ U.S.: (5662) 276-4300, 7 AM to 4 PM, Pacific Time, Monday through Friday

» Canada: (905) 709-3839, 7 AM to 4 PM, Pacific Time, Monday through Friday

Dayls and hours of support are subject to change without notice. Toll or long distance charges may
apply.

Note: For help using any other software on your system, see the documentation for that software for
technical support.

Purchase Supplies and Accessories

You can purchase genuine Epson accessories at epson.com (U.S. sales) or epson.ca (Canadian sales).
You can also purchase accessories from an Epson authorized reseller. To find the nearest one, call 800-
GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

Parent topic: Solving Problems

Where to Get Help (Latin America)

If you need to contact Epson for technical support services, use the following support options.

Internet Support

Visit Epson's support website at latin.epson.com/support and select your product for solutions to
common problems with your product. You can download utilities and documentation, get FAQs and
troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative

Before you call Epson for support, please have the following information ready:

* Product name

* Product serial number (located on a label on the product)

» Proof of purchase (such as a store receipt) and date of purchase

» Computer configuration

» Description of the problem
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Then call:

Country Telephone
Argentina (54 11) 5167-0300
0800-288-37766
Bolivia* 800-100-116
Brazil State capitals and metropolitan areas: 3004-6627
Other areas: 0800-377-6627 / 0800-EPSONBR
Chile (56 2) 2484-3400
Colombia Bogota: (67 1) 602-4751
Other cities: 01-8000-915235
Costa Rica 800-377-6627

Dominican Republic*

1-888-760-0068

Ecuador* 1-800-000-044
El Salvador* 800-6570
Guatemala* 1-800-835-0358
Mexico Mexico City: (52 55) 1323-2052
Other cities: 01-800-087-1080
Nicaragua* 00-1-800-226-0368
Panama* 00-800-052-1376
Paraguay 009-800-521-0019
Peru Lima: (51 1) 418-0210
Other cities: 0800-10126
Uruguay 00040-5210067
Venezuela (58 212) 240-1111

* Contact your local phone company to call this toll-free number from a mobile phone.

If your country does not appear in the list, contact the sales office in the nearest country. Toll or long

distance charges may apply.
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Note: For help using any other software on your system, see the documentation for that software for
technical support.

Purchase Supplies and Accessories

You can purchase genuine Epson accessories from an Epson authorized reseller. To find the nearest
reseller, visit latin.epson.com or call your nearest Epson sales office.

Parent topic: Solving Problems
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Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S.) or
this site (Canada) for information on how to return your Epson products for proper disposal.

Windows System Requirements
Mac System Requirements

General Specifications

Dimension Specifications

Electrical Specifications
Environmental Specifications
Safety and Approvals Specifications

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating
systems:

* Windows 11

* Windows 10

* Windows 8.x

* Windows 7

* Windows Server 2008 or later

Windows Server does not support Document Capture Pro.
Parent topic: Technical Specifications

Mac System Requirements
To use your product and its software, your Mac should use one of these operating systems:
*+ macOS 13.x
* macOS 12.x
* macOS 11.x
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*+ macOS 10.15.x
*+ macOS 10.14.x
* macOS 10.13.x
* macOS 10.12.x
+ OSX10.11.x
+ OS X 10.10.x
+ OS X 10.9.x

Note: The UNIX File System (UFS) for OS X and Fast User Switching on OS X is not supported.

Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.), epson.ca/support (Canada), or latin.epson.com/support (Latin America),
select your product, and select Downloads.

Parent topic: Technical Specifications
General Specifications

Note: Specifications are subject to change without notice.

Scanner type Sheet feed, one pass duplex, color
Photoelectric device CIS
Effective pixels 5100 x 9300 pixels at 600 dpi

DS-C330: 2550 x 36000 pixels at 300 dpi
DS-C490:2550 x 64500 pixels at 300 dpi

Document size DS-C330: Maximum 8.5 x 120 inches (215.9 x 3048 mm)
DS-C490: Maximum 8.5 x 220 inches (215.9 x 5588 mm)
Minimum: 2 x 2 inches (50.8 x 50.8 mm)

Note: Maximum length may vary depending on the scanning method
and resolution.

Paper input Faceup loading
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Paper output

Paper capacity
Scanning resolution

Output resolution

Color Depth

Interface
Light source

Vertical path position: Facedown ejection

Straight path position: Faceup ejection

20 sheets of paper at 21 Ib (80 g/m?) weight

600 dpi (main scan)

600 dpi (sub scan)

50 to 1200 dpi in 1 dpi increments (when scanning with a computer)

Note: Available resolutions may vary depending on the scanning
method.

Color:

30 bits per pixel internal (10 bits per pixel per color)
24 bits per pixel external (8 bits per pixel per color)
Grayscale:

10 bits per pixel internal

8 bits per pixel external

Black-and-white:

10 bits per pixel internal

1 bit per pixel external

Hi-speed USB

RGB LED

Parent topic: Technical Specifications

Dimension Specifications

Height

Width
Depth

Vertical path position: 4.9 inches (125 mm)
Straight path position: 4.7 inches (118 mm)
11.7 inches (296 mm)

Vertical path position: 4.1 inches (104 mm)
Straight path position: 5 inches (128 mm)
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Weight DS-C330: Approximately 4 Ib (1.8 kg)
DS-C490: Approximately 4.2 Ib (1.9 kg)

Note: Dimensions do not include projecting parts.

Parent topic: Technical Specifications
Electrical Specifications

Scanner

Note: Check the label on the product and the AC adapter for voltage information. Power consumption
varies depending on operating conditions or whether an option is installed.

Rated DC input power supply DC 24V

voltage

Rated DC input current 1A

Power consumption DS-C330:
Operating: 10 W (approximate)
Ready mode: 3.3 W (approximate)
Sleep mode: 1 W (approximate)
Power off mode: 0.1 W (approximate)
DS-C490:
Operating: 13 W (approximate)
Ready mode: 3.6 W (approximate)
Sleep mode: 1 W (approximate)
Power off mode: 0.1 W (approximate)

AC Adapter

AC adapter model 100 to 240 V model: A461H

Rated input current 1A
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Rated frequency range 50 to 60 Hz

Rated output power supply DC24V
voltage

Rated output current 1A
Parent topic: Technical Specifications

Environmental Specifications

Temperature Operating: 41 to0 95 °F (5to 35 °C)
Storage: —13 to 140 °F (-25 to 60 °C)

Humidity Operating: 15 to 80% RH

(non-condensing) Storage: 15 to 85% RH

Operating conditions Ordinary office or home conditions

Note: Avoid operating the product in direct sunlight, near a strong light source, or in extremely dusty
conditions.

Parent topic: Technical Specifications

Safety and Approvals Specifications

Scanner
United States EMC: FCC part 15 Subpart B class B
Canada EMC: CAN ICES-3 (B)/NMB-3 (B)
AC Adapter (A461H)
United States Safety: UL60950-1

EMC: FCC part 15 Subpart B class B
Canada Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN ICES-3 (B)/NMB-3 (B)
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Parent topic: Technical Specifications
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Notices

Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S.) or
this site (Canada) for information on how to return your Epson products for proper disposal.

Important Safety Instructions

Restrictions on Copying

Default Delay Times for Power Management for Epson Products
Binding Arbitration and Class Waiver

Trademarks

Copyright Notice

Important Safety Instructions
Follow these safety instructions when setting up and using the product.

Read all these instructions, and follow all warnings and instructions marked on the product.
Place the product close enough to the computer for the interface cable to reach it easily.

Do not place or store the product outdoors, in a car, near excessive dirt or dust, water, heat sources,
or in locations subject to shocks, vibrations, condensation, high temperature or humidity, direct
sunlight, strong light sources, or rapid changes in temperature or humidity.

Do not use with wet hands.

When connecting this product to a computer or other device with a cable, ensure the correct
orientation of the connectors. Each connector has only one correct orientation. Inserting a connector
in the wrong orientation may damage both devices connected by the cable.

Do not insert objects into any opening as they may touch dangerous voltage points or short out parts.
Beware of electrical shock hazards.

Place the product on a flat, stable surface that extends beyond the base of the product in all directions.
If you place the product by the wall, leave at least 3.9 inches (10 cm) between the back of the product
and the wall.

After replacing consumable parts, dispose of them correctly following the rules of your local authority.
Do not disassemble them.
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* Never disassemble, modify, or attempt to repair the product or a product option by yourself except as
specifically explained in this guide.

AC Adapter

* Do not place or store the AC adapter outdoors, in a car, near excessive dirt or dust, water, heat
sources, or in locations subject to shocks, vibrations, condensation, high temperature or humidity,
direct sunlight, strong light sources, or rapid changes in temperature or humidity.

» Place the product and the AC adapter near an electrical outlet where the adapter can be easily
unplugged.

+ The AC power cord should be placed to avoid abrasions, cuts, fraying, crimping, and kinking.

* Do not place objects on top of the AC power cord and do not allow the AC adapter or the power cord
to be stepped on or run over. Be particularly careful to keep the AC power cord straight at the end and
the point where it enters the AC adapter.

» Use only the AC adapter that comes with your product. Using any other adapter could cause fire,
electrical shock, or injury.

* Use only the power cord that comes with your product. Use of another cord may cause fires or shock.
Do not use the cord with any other equipment.

» The AC adapter is designed for use with the product with which it was included. Do not attempt to use
it with other electronic devices unless specified.

» Use only the type of power source indicated on the AC adapter's label, and always supply power
directly from a standard domestic electrical outlet with the AC adapter that meets the relevant local
safety standards.

* Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on
and off.

 If you use an extension cord with the product, make sure the total ampere rating of the devices
plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere
rating.

» Never disassemble, modify, or attempt to repair the AC adapter by yourself except as specifically
explained in the product's guides.

+ If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are fuses in
the plug, make sure you replace them with fuses of the correct size and rating.

» Unplug the product and the AC adapter, and refer servicing to qualified service personnel under the
following conditions: The AC adapter or plug is damaged; liquid has entered the product or the AC
adapter; the product or the AC adapter has been dropped or the case has been damaged; the product
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or the AC adapter does not operate normally or exhibits a distinct change in performance. (Do not
adjust controls that are not covered by the operating instructions.)

* Unplug the product and the AC adapter before cleaning. Clean with a damp cloth only. Do not use
liquid or aerosol cleaners.

« If you are not going to use the product for a long period, be sure to unplug the AC adapter from the
electrical outlet.
uUsB

» Use only the USB cable supplied with your product. Using any other USB cable could cause fire,
electrical shock, or injury.

» The USB cable is designed for use with the product with which it was included. Do not attempt to use it
with other electrical devices unless specified.

» The USB cable should be placed to avoid abrasions, cuts, fraying, crimping, and kinking.

* Do not place objects on top of the USB cable and do not allow the cable to be stepped on or run over.
Be particularly careful to keep the USB cable straight at the end.

* If you are not going to use the product for a long period, unplug the USB cable from the computer.

» Unplug the product and the USB cable, and refer servicing to qualified service personnel under the
following conditions: Liquid has entered the product; the product has been dropped or the case has
been damaged; the product does not operate normally or exhibits a distinct change in performance.
(Do not adjust controls that are not covered by the operating instructions.)

Parent topic: Notices

Restrictions on Copying
Observe the following restrictions to ensure responsible and legal use of your scanner.
Copying of the following items is prohibited by law:

» Bank bills, coins, government-issued marketable securities, government bond securities, and
municipal securities

* Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage
» Government-issued revenue stamps, and securities issued according to legal procedure
Exercise caution when copying the following items:

» Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes,
concession tickets, etc.

» Passports, driver's licenses, warrants of fitness, road passes, food stamps, tickets, etc.
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Note: Copying these items may also be prohibited by law.

Restriction on disassembling and decompiling

You may not disassemble, decompile, or otherwise attempt to derive the source code of any software
included with this product.

Parent topic: Notices

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets
Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.

Parent topic: Notices

Binding Arbitration and Class Waiver

1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND
CLASS ARBITRATIONS

1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term
"Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim,
controversy or action between you and Epson arising out of or relating to this Agreement, Epson
branded products (hardware and including any related software), or other transaction involving you and
Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation,
ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more
specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement,
(c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson
also agree, notwithstanding Section 1.6, that a court, not an arbitrator, may decide if a claim or cause of
action is for an IP Claim.

1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration
according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE
OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED.
Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized
arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but
excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see
Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C.
§1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement
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memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this
Agreement.

1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to
try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to
resolve the Dispute within the sixty (60) days), you or Epson may commence an arbitration. Notice to
Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3131 Katella Ave., Los
Alamitos, CA 90720 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent
address Epson has in its records for you. For this reason, it is important to notify us if your address
changes by emailing us at EAlLegal@ea.epson.com or writing us at the Epson Address above. Notice of
the Dispute shall include the sender's name, address and contact information, the facts giving rise to the
Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson
and you agree to act in good faith to resolve the Dispute before commencing arbitration.

1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small
claims court of your state or municipality if the action is within that court's jurisdiction and is pending only
in that court.

1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT
EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL
CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR
REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE
CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE
ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING
WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED.
ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN
ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS
WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION
PROCEEDING.

1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by
the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration
on a class or representative basis (the "JAMS Rules"), available at http://www.jamsadr.com or by calling
1-800-352-5267, and under the rules set forth in this Agreement. All Disputes shall be resolved by a
single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the
selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not
any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising
out of or relating to the interpretation, applicability, enforceability or formation of this Agreement,
including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad
delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or
cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1
above. The arbitrator shall be empowered to grant whatever relief would be available in a court under
law or in equity. The arbitrator may award you the same damages as a court could, and may award
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declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent
necessary to provide relief warranted by that party's individual claim. In some instances, the costs of
arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration
than in court. The arbitrator's award is binding and may be entered as a judgment in any court of
competent jurisdiction.

You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by
telephone shall take place in a location reasonably accessible from your primary residence, or in Orange
County, California, at your option.

a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties
agree to the following procedure:

(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount
of damages sought to be recovered. You can find a copy of a Demand for Arbitration at
http://www.jamsadr.com ("Demand for Arbitration").

(i) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North
State College Blvd., Suite 600 Orange, CA 92868, U.S.A.

(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute
Notice), or as otherwise agreed by the parties.

b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed
to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled.
The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during
the arbitration.

c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator
fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.

d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive
of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater
than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount
of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if
any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney
reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as
agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and
expenses to be paid by Epson pursuant to this Section 1.6d).

e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced
involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section
1.6d) above does not limit your rights to attorney's fees and expenses under applicable law;
notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and
expenses.
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1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual
arbitration procedure and waiver of class and representative proceedings specified in this
Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent
to this Agreement (including without limitation the purchase, download, installation of the
Software or other applicable use of Epson Hardware, products and services) that specifies (i)
your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding
individual arbitration procedure and waiver of class and representative proceedings specified in
this Section 1. In the event that you opt-out consistent with the procedure set forth above, all
other terms shall continue to apply, including the requirement to provide notice prior to litigation.

1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you
and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and
class action waiver provisions (other than a change to Epson's address) in this Agreement, Epson will
obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the
applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in
accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you
timely elected to opt-out when you first assented to this Agreement).

1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be
severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not
apply to the prohibition against class or representative actions as provided in Section 1.5. This
means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1)
shall be null and void.
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Trademarks

EPSON® and Epson Smart Panel® are registered trademarks, the EPSON logo is a registered logomark,
and Epson Connect™ is a trademark of Seiko Epson Corporation.

Microsoft and Windows are trademarks of the Microsoft group of companies.

Apple, App Store, Mac, macOS, OS X, and AirPrint are trademarks of Apple Inc., registered in the U.S.
and other countries.

Google® is a registered trademark and Android™ and Google Play™ are trademarks of Google LLC.

General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

EPSON
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Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

libTIFF Software Acknowledgment
A Note Concerning Responsible Use of Copyrighted Materials
Copyright Attribution
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libTIFF Software Acknowledgment
Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose
is hereby granted without fee, provided that (1) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
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IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
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A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.
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Copyright Attribution
© 2023 Epson America, Inc.
8/23
CPD-63189R1
Parent topic: Copyright Notice
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